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Notices 

LAND-PAK™ 
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Revision C 
February 2008 

 

Serial Number:   
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Copyright  

© 2008 by NavCom Technology, Inc. 

All rights reserved. No part of this work or the 
computer program(s) described herein may be 
reproduced, stored, or transmitted by any means, 
without the expressed written consent of the copyright 
holders. Translation in any language is prohibited 
without the expressed written consent of the copyright 
holders. 

Trademarks 

‘find your way’, ‘NavCom Globe’ and ‘NAVCOM 
TECHNOLOGY’ logos are trademarks of NavCom 
Technology, Inc. StarFire™ is a registered trademark 
of Deere & Company. All other product and brand 
names are trademarks or registered trademarks of 
their respective holders. 
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FCC Notice 

The NavCom manufactured products comply with 
Part 15 of the FCC Rules. Operation is subject to the 
following two conditions:  

1. This device may not cause harmful 
interference, and  

2. This device must accept any interference 
received, including interference that may 
cause undesired operation. 

The NavCom manufactured products have been 
tested in accordance with FCC regulations for 
electromagnetic interference. This does not 
guarantee non-interference with other equipment. 
Additionally, the products may be adversely affected 
by nearby sources of electromagnetic radiation. 

The Global Positioning System is under the control of 
the United States Air Force. Operation of the GPS 
satellites may be changed at any time and without 
warning.  

The FCC compliance of other components within this 
system can be found inside the respective user 
guides or by contacting the manufacturer directly. 

User Notice 

NavCom Technology, Inc. shall not be responsible for 
any inaccuracies, errors, or omissions in information 
contained herein, including, but not limited to, 
information obtained from third party sources, such as 
publications of other companies, the press, or 
competitive data organizations.  

This publication is made available on an “as is” basis 
and NavCom Technology, Inc. specifically disclaims 
all associated warranties, whether express or implied. 
In no event will NavCom Technology, Inc. be liable for 
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direct, indirect, special, incidental, or consequential 
damages in connection with the use of or reliance on 
the material contained in this publication, even if 
advised of the possibility of such damages. NavCom 
Technology, Inc. reserves the right to make 
improvements or changes to this publication and the 
products and services herein described at any time, 
without notice or obligation. 

Limited Warranty 

NavCom Technology, Inc., warrants that its products 
will be free from defects in workmanship at the time of 
delivery. Under this limited warranty, parts found to 
be defective or defects in workmanship will be 
repaired or replaced at the discretion of NavCom 
Technology, Inc., at no cost to the Buyer, provided 
that the Buyer returns the defective product to 
NavCom Technology, Inc. in the original supplied 
packaging and pays all transportation charges, 
duties, and taxes associated with the return of the 
product.  Parts replaced during the warranty period 
do not extend the period of the basic limited warranty. 

This provision does not extend to any NavCom 
Technology, Inc. products, which have been 
subjected to misuse, accident or improper installation, 
maintenance or application, nor does it extend to 
products repaired or altered outside the NavCom 
Technology, Inc. production facility unless authorized 
in writing by NavCom Technology, Inc. 

This provision is expressly accepted by the buyer in 
lieu of any or all other agreements, statements or 
representations, expressed or implied, in fact or in 
law, including the implied warranties of 
merchantability and fitness for a particular purpose 
and of all duties or liabilities of NavCom Technology, 
Inc. To the buyer arising out of the use of the goods, 
and no agreement or understanding varying or 
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extending the same will be binding upon NavCom 
Technology, Inc. unless in writing, signed by a duly-
authorized officer of NavCom Technology, Inc. 

This limited warranty period is one (1) year from date 
of purchase. 

StarFire™ Licensing 

The StarFire™ signal requires a subscription that 
must be purchased in order to access the service. 
Licenses are non-transferable, and are subject to the 
terms of the StarFire™ Signal License agreement. 
For further details on the StarFire™ Signal Network, 
its capabilities, terms and conditions visit 
www.navcomtech.com or send an email inquiry to 
sales@navcomtech.com 

USG FAR 

Technical Data Declaration (Jan 1997) 

The Contractor, NavCom Technology, Inc., hereby 
declares that, to the best of its knowledge and belief, 
the technical data delivered herewith under 
Government contract (and subcontracts, if 
appropriate) are complete, accurate, and comply with 
the requirements of the contract concerning such 
technical data 

Global Positioning System 

Selective availability (S/A code) was disabled on 02 
May 2000 at 04:05 UTC. The United States 
government has stated that present GPS users use 
the available signals at their own risk. The US 
Government may at any time end or change 
operation of these satellites without warning. 

The U.S. Department of Commerce Limits 
Requirements state that all exportable GPS products 
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contain performance limitations so that they cannot 
be used to threaten the security of the United States. 

Access to satellite measurements and navigation 
results will be limited from display and recordable 
output when predetermined values of velocity and 
altitude are exceeded. These threshold values are far 
in excess of the normal and expected operational 
parameters of the SF-2040 GPS Sensor. 
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Use of this Document 

This User Guide is intended to be used by someone 
familiar with the concepts of GPS and satellite 
surveying equipment. 

 Note indicates additional information 
to make better use of the product. 

 This symbol means Reader Be 
Careful. Indicates a caution, care, 
and/or safety situation. The user might 
do something that could result in 
equipment damage or loss of data. 

 This symbol means Danger. The user 
is in a situation that could cause bodily 
injury. Before working on any 
equipment, be aware of the hazards 
involved with electrical and RF circuitry 
and be familiar with standard practices 
for preventing accidents. 

Revisions to this User Guide can be obtained in a 
digital format from 
http://www.navcomtech.com/Support/ 

Related Documents 

StarUtil User Guide 
P/N 96-310008-3001 

Describes the operation and use of NavCom’s 
Windows based control program (included on CD) 

 xv 
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Technical Reference Manual  
P/N 96-3120001-3001 

Describes the control and output data message 
formats utilized by this instrument (for customer 
programming purposes; included on CD) 

RINEXUtil User Guide  
P/N 96-310021-2101 

Describes the conversion program used for NavCom 
proprietary output data message formats to RINEX 
ver 2.10 observation and navigation files (for 
customer programming purposes; included on CD) 

Integrators Toolkit 
P/N 97-310020-3001 

Provides additional instruction and tools for 
developing control programs for this instrument (not 
included in the packaging material; contact 
http://www.navcomtech.com/Support/ for a copy) 

NavCom Release Notes 

Describes software updates for NavCom products. 
Current and archived Release Notes are available on 
the NavCom web site:  
http://www.navcomtech.com/Support/DownloadCente
r.cfm?category=releasenotes.  

NavCom Customer Support provides software 
updates described in the Release Notes. Submit a 
request for software updates via the Request Support 
web page.  
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Related Standards 

ICD-GPS-200 

NAVSTAR GPS Space Segment / Navigation User 
Interfaces Standard. ARINC Research Corporation; 
2250 E. Imperial Highway; El Segundo, California 
90245 

RTCM-SC-104 

Recommended Standards For Differential GNSS 
Service. Radio Technical Commission For Maritime 
Services; 1800 N. Kent St, Suite 1060; Arlington, 
Virginia 22209 

CMR, CMR+ 

Compact Measurement Record; Trimble Navigation 
Limited; 935 Stewart Drive; Sunnyvale, CA 94085 

NMEA-0183 

National Marine Electronics Association Standard For 
Interfacing Marine Electronic Devices. NMEA 
National Office; 7 Riggs Avenue; Severna Park, 
Maryland 21146 

Publicly-Operated SBAS Signals 

RTCA/DO-229D  

The Radio Technical Commission for Aeronautics 
(RTCA) develops consensus-based 
recommendations regarding communications, 
navigation, surveillance, and air traffic management 
(CNS/ATM) system issues. 

RTCA. 1828 L Street, NW, Suite 805, Washington, 
DC 20036.  
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xviii 

These organizations implement the RTCA/DO-229D 
standard set by RTCA: 

WAAS (Wide Area Augmentation System) 

U.S. Department of Transportation. Federal Aviation 
Administration. 800 Independence Ave, SW, 
Washington, DC 20591 

EGNOS (European Geostationary Navigation Overlay 
Service) 

European Space Agency. 8, 10 rue Mario-Nikis,  
F-75738 Paris Cedex 15, France. 

MSAS (MTSAT Satellite-based Augmentation 
System) 

Japan Civil Aviation Bureau. Ministry of Transport. 
Kasumigaseki 2-1-3, Chiyoda-ku, Tokyo 100, Japan. 

GAGAN (GPS Aided Geo Augmented Navigation) 

Indian Space Research Organization. Antariksh 
Bhavan, New Bel Road, Bangalore - 560 094, India. 
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Chapter 1 .............................. Introduction 

The LAND-PAK™ is a complete NavCom-qualified 
end-user system designed for land survey 
applications. The LAND-PAK pairs NavCom products 
with complimentary technologies and solutions, 
providing land surveyors a complete turn-key system 
that does everything from field data collection to office 
processing. 

Unique Features 

The LAND-PAK has many unique features: 

 A Solution that Works 

The LAND-PAK’s controller solution from Carlson 
provides cutting edge hardware with the most popular 
and easy to use software on the market, SurvCE. 
Satel’s powerful radio modems give the LAND-PAK a 
wider coverage area, allowing longer distances 
between stations.  

 Higher accuracy and reliability 

With Satel’s radio modems and the RTK option on the 
SF-2040 receivers, the LAND-PAK is capable of 
performing centimeter accurate RTK surveys. The 
RTK algorithm developed by NavCom provides fast 
initialization and the NCT ultra compact binary data 
format for RTK ensures robust data throughput. The 
sensor can utilize NCT, RTCM, CMR and CMR+ data 
streams from other base stations to minimize base 
rover separation and allow for flexibility with pre-
existing GPS survey systems.  

 2-19 
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 GPS Performance 

The NavCom SF-2040 receivers use the NavCom 
NCT-2100D GPS Engine including the fourth 
generation Touchstone™ ASIC family, of which more 
than 40,000 are in use worldwide. Incorporated are 
NavCom patented interference suppression and 
multi-path mitigation, a 5Hz raw data rate (up to 50Hz 
optional), and 5Hz geodetic-quality positioning (up to 
25Hz optional). 

 RTK Extend™ 
1RTK Extend™ enables continuous RTK-level 
positioning accuracy during radio communication 
outages by utilizing NavCom’s global StarFire™ 
corrections.  

Traditionally, when an RTK rover loses 
communication with the base station, it is unable to 
continue to provide position updates for more than a 
few seconds, resulting in user down-time and 
reduced productivity. With RTK Extend™, a NavCom 
StarFire™ receiver operating in RTK mode, can 
transition to RTK Extend™ mode and maintain 
centimeter level positioning during communication 
loss for up to 15 minutes. RTK Extend™ allows more 
efficient and uninterrupted work, enabling focused 
concentration on the work rather than the tools. 

 A complete portable system 

The LAND-PAK is a highly integrated solution 
designed for productivity with minimal setup time and 
maximum portability. Covering the entire land survey 
process, it contains a complete base and rover 
system for field data collection. Optional software for 
data analysis and processing is also available.  

1Separate Software Option Required 

2-20 
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Typical Applications 

 Cadastral (Boundary) Surveys 

 Geodetic Surveys (Control) Surveys 

 Topographic Surveys 

 Stake-Out Surveys 

 As-Built Surveys 

System Description 

NavCom SF-2040 GPS 
Sensors 

The LAND-PAK includes 
the NavCom SF-2040 
Sensor for both the base 
station and rover. The SF-2040 is a 24-channel dual 
frequency precision GPS sensor with two additional 
channels for receiving Satellite Based Augmentation 
System (SBAS) signals and an L-Band demodulator 
for reception of NavCom’s StarFire™ Network 
correction service, for autonomous decimeter-level 
position accuracy, anywhere in the world, anytime. 
The sensor can output proprietary raw data as fast as 
50Hz (optional) and Position Velocity Time (PVT) 
data as fast as 25Hz (optional) through two 115kbps 
serial ports with less than 20ms latency.  

The SF-2040 has a built-in L-Band demodulator for 
reception of NavCom’s StarFire™ Network correction 
service. The sensor simultaneously accepts 
additional DGPS corrections (WAAS/EGNOS) 
assuring seamless position output. 
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 Integrated GPS and L-Band Antenna 

The all-in-one housing incorporates our compact GPS 
antenna with excellent tracking performance and a 
stable phase center for GPS L1 and L2. The robust 
assembly features a standard 5/8” BSW thread for 
mounting directly to a surveyor’s pole, tripod, or mast.  

 Communications 

The SF-2040 provides two 7-pin female LEMO 
connector communication ports, labeled COM1 and 
COM2, located at the bottom front of the sensor (as 
shown in Figure 1). Each conforms to the EIA RS232 
standard with data rates from 1.2 to 115.2kbps.  

COM1 is the control port, and COM2 is the data port 
(see Figure 4 for a schematic of the LAND-PAK 
interfacing). 

 
Figure 1: SF-2040, Viewed From Bottom 

2-22 
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 Refer to the supplied SF-2040 GPS 
Product User Guide for further 
information about the SF-2040. 

Base Station and Rover Radio Modems 

The LAND-PAK includes a 
base station and a rover radio 
modem.  

 Refer to The LAND-
PAK Configurations 
section below for the 
specific radio modems used in the 
current LAND-PAK configurations. 

 Set the radio modems only to a 
licensed frequency. It must comply 
with local regulatory authorities.  

 User Interface 

The LAND-PAK radio modems are configurable via 
SurvCE software on the Explorer 600+ controller. 

Additionally, the radio modems are configurable 
without any external device via the integrated LCD 
display and four soft keys. The soft keys access on-
screen menus. 

During operation, the LCD display shows RF 
frequency, battery status, data port speed, and signal 
strength (in dBm).  

 LED Indicators 

 
Figure 2: Radio Modem LED Indicators  
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The LED indicators provide a quick status view of 
both the radio channel and the serial interface with 
the GPS.   

The CTS LED illuminates when the radio modems 
are powered on. Refer to Table 1 for LED indications.  

Table 1: Radio Modem LED Indications 

 

LED Description Active Status 
RTS Request To Send Red 
CTS Clear To Send Red 

TD 

Transmit Data 
(Input of the data 
to be transmitted 
from the DTE to 
the radio modem.) 

Red = data transmit 
Green = test Tx active 

RD 

Receive Data 
(Output of the 
data received 
from the radio 
modem to the 
DTE.) 

Red 

CD Carrier Detect 
(radio status) 

Red = transmission 
Orange = noise  
Green = reception 
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Explorer 600+ Data Collector 

The Carlson Explorer 600+ high-speed (624 MHz), 
hand-held data collector features a liquid crystal 320 
x 240 QVGA-TFT color, sunlight-readable display 
with a touch screen and LED backlight. It is equipped 
with 128MB of SDRAM and 512MB of internal 
compact flash memory.  

Carlson SurvCE data collection software for land 
surveying applications is installed on the Windows CE 
.NET Professional operating system.  

The supplied rechargeable Nickel Metal Hydride 
(NiMH) battery pack can provide up to twelve hours of 
operating time on a full charge (depending on power 
management and use). 

The Explorer 600+ provides WiFi and Bluetooth, a 
USB port and a Serial port, and a Compact Flash 
(CF) slot. 

The weather resistant shell, rated to withstand wind-
driven rain, has a keyboard designed for surveyors 
and six LED Indicators, including a charge/low battery 
indicator. The Explorer 600+ comes with a cradle for 
attachment to the rover pole. 

 Refer to the supplied Carlson Explorer 
600+ user manual for further 
information. 

 Always use the supplied stylus to 
interact with the Explorer 600+ touch 
screen. Never use sharp objects. Use 
the supplied screen protectors to 
increase the life of the touch screen.  
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 User Interface 

 
Figure 3: Carlson Explorer 600+ User Interface 

The Carlson Explorer 600+ has a 53-key keypad. It 
provides the functionality of a full-sized keyboard 
through the use of multi-functional modifier keys. Four 
LEDs located to the left and right of the power button 
indicate the active state of the modifier keys. 

 2nd Key: Press to 
access the 
characters and 
functions in the 
blue bottom half of 
the keys.  

 Alt Key: Press to 
access the orange 
letter hot keys 
below the Alpha Letters A thru Z. For detailed 
information about the hot keys, refer to the 
supplied Carlson SurvCE manual. 

 The functions of the Fn key and the 1st LED 
are not applicable to the LAND-PAK. 
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 Operation 

 Power Off: Press and hold the power button for 
approximately 10 seconds. This action terminates 
active applications, and ceases serial port 
operations. 

 Suspend Mode: Press and immediately release 
the power button. The display turns off, but active 
applications are not shut down (except serial port 
operations). To exit suspend mode, press and 
release the power button. The display turns on, 
suspended applications resume running, but 
serial port operations must be restarted. Use 
suspend mode to conserve battery power. 

 Warm Re-Boot: In Windows CE, select Start > 
Programs > Tools > Warm Re-Boot. 

SurvCE Software 

Carlson SurvCE is a complete data collection system 
for Real Time (RTK) GPS.  

 Refer to Chapter 5 SurvCE Software 
Operation for a quick start setup and 
operation of SurvCE. Refer to the 
supplied Carlson SurvCE manual for 
details not covered in this guide. 

 SurvCE Upgrade 

 Contact NavCom Technology prior to 
upgrading the factory installed version 
of SurvCE on the Explorer 600+. If 
appropriate, download the latest 
version of Carlson SurvCE from the 
Carlson web site at 
http://www.carlsonsw.com.  

To install SurvCE on the Explorer 600+, a PC requires 
Microsoft ActiveSync on Windows XP or earlier, or the 
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Windows Mobile Device Center on Windows Vista. 
ActiveSync is on the supplied SurvCE CD. The latest 
versions of either program are available from Microsoft.  

 SurvCE Installation on Windows XP or earlier: 

 Boot-up Windows CE on the Explorer 600+. If 
Windows CE is already running, close any open 
applications.  

 Run PC Link from the desktop. The PC Link 
window opens and closes quickly.  

 Connect the PC and the Explorer 600+ with the 
supplied USB cable. (The USB cable is in the 
office transit case).  

o ActiveSync starts automatically. The New 
Partnership window opens.  

 Select No.  

 Click the Next button.  

o The ActiveSync window opens. A guest 
connection is indicated.  

 Click the Explore button.  

 Browse to the folder with the downloaded SurvCE 
exe file.  

 Double-click the exe file.  

o The SurvCE setup wizard opens. Follow the 
on-screen instructions. When asked to check 
the mobile device for additional steps, a box 
with a stopped progress bar will be open on 
the Explorer 600+.  

 Tap the OK button in the top right corner of the box.  

o Installation continues. When the box 
disappears, the installation is complete.  

 On the PC, close the wizard and ActiveSync. 
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TruBlu™ Module 

The TruBlu™ module is a wireless 
transceiver that provides wireless 
connectivity with the Bluetooth® 
enabled Explorer 600+ data collector 
within a range of 100 feet (30 meters). 

 Features 

 Water-resistant, sealed unit  

 Internal flashing blue LED clearly indicates 
operation  

 FCC & CE certified when used with NavCom GPS 
Receivers  

 Contains Bluetooth-certified components  

 No wires 

TruBlu™ delivers the convenience of wireless control 
and logging of up to 10Hz position records in the 
Explorer 600+. Use a serial cable to download the 
internal memory and for real-time position / data 
transfers greater than 10Hz. 

 No batteries required 

TruBlu™ is powered directly by its host NavCom GPS 
unit, so it requires no additional batteries for usage. 
Its power needs are minimal; for example, when the 
SF-2040 is powered by NavCom batteries, power life 
will be reduced by less than 10% from TruBlu™ use. 

 Compact size 

TruBlu™ is only 41mm x 28mm x 22mm (1 5/8” x 1 
1/8” x 7/8”), taking up very little space. 
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Office Software 

 Carlson X-Port – This program is a file transfer 
and data editing utility. In the office, X-Port is used 
to communicate with the Explorer 600+ data 
collector, transfer files, process coordinates, and 
convert coordinates and raw data formats. 

 Refer to Chapter 6 Data Transfer for a 
quick start to the use of X-Port. The 
Carlson X-Port manual may be 
obtained from the Carlson web site: 
http://www.carlsonsw.com. 

 NavCom StarUtil – This program is designed to 
setup and view many (but not all) of the SF-2040 
functions. In addition to its setup capabilities, 
StarUtil can capture and log data, upload new 
software and licenses to the three internal 
processors, and query and display various 
receiver performance functions. The StarUtil 
software and user guide is supplied on the CD in 
the office supplies transit case. 
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The LAND-PAK Interfacing 
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Figure 4: The LAND-PAK Interfacing 

The LAND-PAK Configurations 

The LAND-PAK currently has two configurations: 

 The LAND-PAK LM 

 The LAND-PAK 869 

 Refer to the supplied Satelline-3ASd 
user guide for detailed information on 
the radio modems described below. 

The LAND-PAK LM 

The LAND-PAK LM configuration includes the 
SATELLINE-3ASd Epic high power 10-Watt 
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transmitter for the base station assembly and the 
SATELLINE-3ASd for the rover assembly. They are 
set to communicate at 38400 baud. The operating RF 
frequency range of the LAND-PAK LM configuration 
is 450 MHz to 470 MHz. 

 When ordering the LAND-PAK LM 
configuration, the user must specify 
the desired operating frequency of the 
radio modems. The specified 
frequency is set at the factory. It is the 
responsibility of the user to ensure 
that the requested frequency complies 
with local regulatory authorities. 

The factory set central RF frequency is listed 
with the serial number on the radio modem. 
The RF frequency can be set within 1MHz of 
the central frequency, at 25KHz increments.  

If retuning beyond 1 MHz is necessary, the 
user must ship the radio to the manufacturer’s 
factory for hardware modification. Any 
shipping and customs charges are the 
responsibility of the customer. 

The LAND-PAK 869 

The LAND-PAK 869 configuration includes two  
SATELLINE-3ASd 869 radio modems for the base 
station assembly and for the rover assembly. They 
are set to communicate at 38400 baud. The 3ASd 
869 radio modem is capable of transmitting up to   
500 mW. The operating RF frequency range of the 
LAND-PAK 869 configuration is 869.400 MHz to 
869.650 MHz.  

The 3ASd 869 radio modem is currently type 
approved in Austria, Belgium, Croatia, 
Czechoslovakia, Denmark, Estonia, Finland, France, 
Germany, Greece, Hungary, Iceland, Ireland, Italy, 
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Latvia, Malta, Norway, The Netherlands, Poland, 
Portugal, Romania, Slovakia, Spain, Sweden, 
Switzerland, Turkey, and The United Kingdom.  

 Please check with local regulatory 
authorities to ensure compliance. 
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Chapter 2 ........................ Inventory Check 

This chapter provides the complete system inventory 
for the LAND-PAK LM configuration.  

 Refer to Appendix A for the complete 
system inventory for the LAND-PAK 
869 configuration. 

The Inventory Check is divided into three sections: 
Base Station Inventory, Rover Inventory, and Office 
Supplies Inventory. 

The system is shipped in five boxes, which contain 
the transit cases and bags listed below. The transit 
cases are labeled on the top. The bags are labeled 
under the NAVCOM logo.  

 Base Station Transit Case 

 Base Bag 

 Rover Transit Case 

 Rover Bag 

 Office Supplies Transit Case 

 Carefully remove equipment from 
transit cases and bags. If any items 
are missing or damaged, immediately 
contact NavCom Customer Support: 

Telephone: +1 (310) 381-2000 

Web:  
http://www.navcomtech.com/Contact/Contact
Support.cfm 
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Base Station Inventory 

This section lists all the supplied equipment in the 
Base Transit Case and the Base Bag. 

 
Figure 5a: Base Transit Case Supplied Equipment 

Table 2: Base Transit Case Parts List 

1 

SF-2040 GIS PM Sensor 
(P/N 92-310045-3001) 
Included and Installed Software Options: 

RTK Software 
(P/N 97-310041-3006) 
RTK Extend 
(P/N 97-310041-3009) 

2 Two Lithium-Ion Battery Packs, 10.8 VDC, 4.4 Ah 
(P/N 59-020102-3001 each) 

3 Tribrach, w/ Optical Plummet, black 
(P/N 60-990007-0001) 

4 Adaptor, Tribrach, Fixed 
(P/N 60-990008-0001) 

5 
Base Transit Case {Not Shown} 
(P/N 79-100106-3001) 

 Continued on next page 

2-36 



 LAND-PAK™ User Guide – Rev. C 

 2-37 

 
 

Figure 5b: Base Transit Case Supplied Equipment 

Base Transit Case Parts List continued 

6 
3ASd EPIC Radio Modem, 10W o/p Power 
(P/N 82-042001-0002) 

7 
Bag for 3ASd EPIC Radio Modem 
(P/N 79-700005-0001) 

8 
12V 8Ah Bag Battery for 3ASd EPIC Radio Modem  
(P/N 59-020152-0001) 

9 
Antenna, Gainflex 435-470 MHz, TNC 
(P/N 82-001015-0003) 

10 
Radio Antenna Cable, 12 ft (3.7m) 
(P/N 94-310058-3012) 

11 
NavCom Base Cable 10 ft (3m) 
(P/N 73-100002-0001) 

12 
Tape Measure & Pocket Rod Combo, 12ft (3.7m) 
(P/N 60-990009-0001) 
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Figure 6: Base Bag Supplied Equipment 

Table 3: Base Bag Parts List 

1 Bag, Tripod {Not Shown} 
(P/N 79-700003-0001) 

2 Tripod, Dual Lock, Fiberglass, Waterproof, 72 in Legs 
(P/N 60-430002-0001) 

3 Bracket, Radio Antenna To Tripod  
(P/N 60-500001-0001) 

4 Snap-Lock Radio Antenna Pole, 6ft  
(P/N 60-440002-0001) 

5 Pole Extension, 6 inch: 1 inch diameter 
(P/N 60-440003-0001) 

6 Radio Antenna Adaptor 
(P/N 88-310055-3002) 
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Rover Inventory 

This section lists all the supplied equipment in the 
Rover Transit Case and the Rover Bag. 

 
Figure 7a: Rover Transit Case Supplied Equipment 

Table 4: Rover Transit Case Parts List 

1 

SF-2040 GIS PM Sensor 
(P/N 92-310045-3001) 
Included and Installed Software Options: 

RTK Software 
(P/N 97-310041-3006) 
RTK Extend 
(P/N 97-310041-3009) 

2 Two Lithium-Ion Battery Packs, 10.8 VDC, 4.4 Ah  
(P/N 59-020102-3001 each) 

3 Serial Cable, 6 Ft Coiled 
(P/N 94-310090-3003) 

4 TruBlu™ Module   
(P/N 92-210182-3001) 

5 Carlson Explorer 600+, Carlson SurvCE w/GPS installed
(P/N 82-061001-0001) {Supplied USB Cable Not Shown} 

6 
Rover Transit Case {Not Shown} 
(P/N 79-100107-3001) 

 Continued on next page 
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Figure 7b: Rover Transit Case Supplied Equipment 

Rover Transit Case Parts List continued 

7 
Extra Orange Styli (Set of 3) for Carlson Explorer 600+ 
(P/N 60-990010-0001) 

8 
Screen Protectors for Carlson Explorer 600+, Set of 5  
(P/N 60-220001-0001) 

9 
Vehicle Charger for Carlson Explorer 600+  
(P/N 59-800004-0001) 

10 
3ASd Radio Modem, 1W o/p Power  
(P/N 82-042001-0001) 

11 
3ASd Battery Cradle  
(P/N 60-990011-0001) 

12 
3ASd Battery with switch 
(P/N 59-020201-0001) 

13 
Bag for 3ASd Radio Modem 
(P/N 79-700005-0002) 

14 

Antenna, Gainflex 435-470 MHz, TNC {The antenna is 
stored in the lower portion of the rover transit case lid.} 
(P/N 82-001015-0003) 

15 
NavCom Cable, DB-9  
(P/N 73-100002-0002) 
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Figure 8: Rover Bag Supplied Equipment 

Table 5: Rover Bag Parts List 

1 Rover Bag {Not Shown} 
(P/N 79-700002-0002) 

2 Pole, Carbon Fiber and Aluminum, 8.5 ft (2.6m) 
(P/N 60-430001-0002) 

3 Bipod, Carbon Fiber, Open Clamp  
(P/N 60-430001-0001) 

4 Cradle for Carlson Explorer 600+  
(P/N 60-570002-0001) 

 
 
 



 LAND-PAK™ User Guide – Rev. C 

Office Supplies Inventory 

This section lists all the supplied equipment in the 
Office Supplies Transit Case.  

 
Figure 9: Office Supplies Transit Case 

Table 6: Office Supplies Transit Case Parts List 

1 

Battery Charger Kit for SF-2040 GIS PM Sensor 
(P/N 92-310092-3001) 
Kit Includes: 

4-Bay Battery Charger w/ Cable (P/N 92-310046-3001) 
Charger Power Supply (P/N 82-02003-5001) 

2 Battery Charger Kit for Carlson Explorer 600+ 
(P/N 59-810001-3001) 

3 Battery Charger for EPIC Radio Modem Bag Battery  
(P/N 59-800002-0001) 

4 

Option: 
110V Battery Charger for 3ASd Radio Modem Battery 
(P/N 59-800001-0001) 
Or 
220V Battery Charger for 3ASd Radio Modem Battery 
(P/N 59-800001-0002) {Not Shown} 

5 Office Supplies Transit Case {Not Shown} 
(P/N 79-100108-3001) 

 Continued on next page 
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Office Supplies Transit Case Parts List continued 

6 User Guide, LAND-PAK  
(P/N 96-310030-3001) 

7 User Guide, SF-2040 GIS PM Sensor 
(P/N 96-310003-3001) 

8 User Guide, Carlson Explorer 600+ 
(P/N 96-000001-0001) 

9 User Guide, Carlson SurvCE  
(P/N 96-000001-0002) 

10 
User Guide, SATELLINE -3ASd Radio Modems 
(P/N 96-000001-0003) 

11 

CD containing User Guides, Reference Material, and 
StarUtil Utility Software/User Guide 
(P/N 96-310006-3001) 
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Chapter 3 .......................Battery Charging 

This chapter provides guidance on battery charging 
for optimum performance. All the battery chargers are 
in the transit case labeled Office Supplies.  
 

 All the LAND-PAK batteries must be 
charged before the test setup of the 
system. Refer to Chapter 4 Function 
Test Setup. 

 For optimum battery life and 
performance, it is important that all 
batteries receive a full charge before 
first use. 

 Refer to Chapter 7 Equipment 
Maintenance for safety instructions 
regarding battery use, storage, and 
disposal.  

SF-2040 GPS Sensor Battery Packs 

The LAND-PAK includes two SF-2040 GPS Sensors, 
each supplied with two lithium-ion battery packs. The 
battery charger has four independent charging bays 
for simultaneous charging.  

 Refer to the supplied SF-2040 GPS 
Product User Guide for details on 
battery use, safety, and disposal. 

 Charge the battery packs only with the 
supplied battery charger (P/N 92-
310046-3001) and supplied charger 
power supply (P/N 82-02003-5001); 
otherwise, damage to the battery 
packs could occur.  
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 Battery Charger LEDs 

Table 7: Sensor Battery Charger LEDs 

 

LED Status 

 
Power

Power On 

Battery Bays 

 Charging 
Charging Complete 

 Battery Charging 

 The SF-2040 battery packs are 
shipped in a partially charged state. 
Complete one full charge cycle (8-10 
hours) before battery use. 

Refer to Figure 9, item 1 for battery charger kit photo. 

1. Connect the power cable to the AC to DC power 
supply. 

2. Connect the power supply jack to the battery 
charger assembly. 

3. Plug the power cable into an AC receptacle. The 
green power LED illuminates. 

4. Insert four battery packs into the charger. The 
LED status is shown in Table 7. 

5. Charge battery packs until the green LED below 
each bay illuminates. 

 Do not short circuit battery contacts. 
Do not store battery packs above 60 
deg C (140 deg F). Do not 
disassemble battery packs. Do not 
expose to fire (explosive hazard).  
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 If the battery packs are left charging 
for longer than 5 days, the charging 
indicator LEDs will shut off. If this 
occurs, place the battery packs in the 
SF-2040 GPS Sensor and power on 
for 10-15 minutes in order to slightly 
discharge the batteries. 

 Remove the battery packs from both 
SF-2040 GPS Sensors if the sensors 
will not be used for over 1 week.  

 Battery Installation 

The SF-2040 GPS Sensor battery packs are keyed to 
prevent improper installation. There are two locking 
clips on either side of the battery end (see Figure 10).  

    
Figure 10: Battery Locking Clips 

The bottom of the sensor has two battery chambers. 
Install each battery pack by sliding it into a chamber. 
Align the channel on the chamber to match the 
battery notch. Press the end firmly until the locking 
clips click. Verify both locking clips are locked in 
place. 

 If both locking clips are not locked in 
place, a battery pack could 
inadvertently drop to the ground. 
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 Battery Removal 

Using the thumb and the middle finger, depress the 
two locking clips firmly. The battery pack should pop 
out enough to be pulled free of the chamber. 

 Battery Testing 

Refer to the supplied SF-2040 GPS Product User 
Guide for details on testing the battery packs in the 
sensor. 
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3ASd Epic Radio Modem Bag Battery 

The LAND-PAK LM configuration includes the 3ASd 
Epic radio modem for the base station. A 12V 8Ah 
bag battery powers the 3ASd Epic radio modem.  

 Charge the bag battery only with the 
supplied bag battery charger (P/N 59-
800002-0001); otherwise, damage to 
the battery could occur.  

 Battery Charger LEDs 

Table 8: Bag Battery Charger LEDs 

LED Status 
 Charging 
 Charging Complete 

 The LED functions printed on the 
battery charger, Fast Charge and 
Float Charge, do not apply to this 
procedure.   

 Battery Charging 

Refer to Figure 9, item 3 for battery charger photo. 

1. Connect the LEMO 2-pin connector end of the 
bag battery charger to the female LEMO 
connector on the bag battery. 

2. Plug the opposite end of the bag battery charger 
into an AC receptacle. The red LED on the 
charger illuminates. If the green LED illuminates, 
the battery is already fully charged, or if not fully 
charged, the battery is malfunctioning. 

3. Charge the bag battery until the green LED 
illuminates. One full charge cycle requires 9-12 
hours to complete. 
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4. Unplug the battery charger. 

 

Male 15-Pin 
Serial  
Connector 

LEMO 2-Pin 
Connector

LEMO 7-Pin 
Connector

Figure 11: NavCom Base Cable 

Refer to Figure 11 for the steps below: 

5. Verify the bag battery is fully charged. Power on 
the radio modem to check the battery voltage: 

a. Connect the serial 15-pin end of the NavCom 
base cable to the female serial connector on 
the bottom right of the radio modem. 

b. Connect the LEMO 2-pin end of the base 
cable to the bag battery. The radio modem 
powers on. (The LEMO 2-pin connector is 
fitted to the red fuse-fit and black cables.)  

The LCD display shows the battery status and 
other settings. The supply voltage is in the top 
right (see Figure 17). A full charge is 13.5V to 
14.70V. 

 The LEMO 7-Pin end of the base 
cable is not used in this procedure.  

6. Disconnect the bag battery if it is fully charged.  
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3ASd and 3ASd 869 Radio Modem Battery 

A 9.6V 2Ah NiMh battery powers both the 3ASd and 
the 3ASd 869 radio modems. The battery is attached 
to a cradle on the back of the radios. The battery 
charger is the same for both types of radio modem. 

The LAND-PAK LM configuration includes one  
battery charger1 for the 3ASd radio modem (rover). 
The LAND-PAK 869 configuration includes two 
battery chargers1, one for each 3ASd 869 radio 
modem (base and rover).  

There is no charging indicator on the battery charger. 
The top of the battery has an on/off switch and a red 
LED. The illuminated red LED indicates power on and 
battery charging. 

 Charge the batteries only with the 
supplied battery charger; otherwise, 
damage to the battery could occur.  

 Battery LED 

Table 9: Rover Radio Modem Battery LED  

LED Status 
 Battery Charging/Radio Modem Power On 

 

 Battery Charging 

Refer to Figure 9, item 4 for battery charger photo. 

1. Connect the serial 9-pin end of the battery 
charger to the female connector on the bottom of 
the radio. 

2. Plug the opposite end of the battery charger into 
an AC receptacle.  

1Battery Charger Option:  
 110V (P/N 59-800001-0001) or 220V (P/N 59-800001-0002) 
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3. Turn on the switch at the top of the radio modem 
battery. The red LED illuminates.  

 The on/off switch must be on to 
charge the battery. If the switch is not 
on, the charger powers the radio (the 
LCD display is on), but does not 
charge the battery.  

4. Charge the battery for 12 hours.  

 The LED does not indicate when the 
charge cycle is complete. When the 
battery is on, the LED is always a 
steady red. Do not charge the rover 
radio modem for more than 72 hours. 

5. Verify the battery is fully charged. A full charge is 
10.5V to 11.1V. The voltage of the battery is 
indicated on the top right of the LCD display (see 
Figure 17).  

6. Turn off the battery and unplug the battery 
charger if the charge cycle is complete. When the 
battery is off, the LED is not lit. 

 It is very important to turn off the 
battery. If the battery remains on, it 
immediately begins to power the radio 
modem when the charger is 
unplugged. The battery will eventually 
drain completely if not turned off.  

 Battery Installation 

 The radio modem has a 4-pin power 
connector on the back. It connects to 
the female power connector on the 
back of the battery.  

1. Turn off the switch on the top of the battery if it is 
on.  
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2. Loosen the screw on the bottom of the battery. 

3. Insert the slots at the top of the battery into the 2 
hooks at the top of the battery cradle. 

4. Lower the bottom of the battery into the bracket at 
the bottom of the battery cradle. 

5. Carefully press the bottom of the battery to 
connect the female and male power connectors. 
The battery snaps into place. 

6. Tighten the screw on the bottom of the battery. 

7. Verify battery function. Turn on the switch on the 
top of the battery. The red LED illuminates. At 
power-on, the LCD display shows the setup 
screen.  

 Battery Removal 

1. Turn off the switch at the top of the battery if it is 
on. The red LED turns off. Unplug the battery 
charger if it is connected.  

2. Loosen the screw on the bottom of the battery. 

3. Grasp the battery at the bottom.  

4. Carefully pull the battery up from the bottom until 
it is free from the bottom bracket of the cradle and 
the 4-pin power connector on the back of the 
radio.  

5. Slowly continue to pull the battery up from the 
bottom. The battery will disengage from the 2 
hooks at the top of the cradle.  

6. After the battery is removed, re-tighten the screw 
on the bottom of the battery to avoid its accidental 
loss. 
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Carlson Explorer 600+ Battery Pack 

This section provides steps to: 

 Charge the battery pack for the Carlson Explorer 
600+ data collector. 

 Boot up Windows CE to verify functionality and to 
verify Carlson SurvCE software is installed.  

A 7.2V 2500mAh NiMH battery pack powers the 
Carlson Explorer 600+. It can provide approximately 8 
to 12 hours of operating time on a full charge 
(depending on power management and use). 

There is no charging indicator on the Explorer 600+ 
battery charger. The CHG LED on the Explorer 600+ 
front panel indicates battery charging status.  

 Charge the battery pack only with the 
supplied battery charger kit (P/N 59-
810001-3001); otherwise, damage to 
the battery pack could occur.  

 For optimum battery performance, 
refer to the supplied Carlson Explorer 
600+ user manual, Power 
Recommendations section. 

 A vehicle charger (P/N 59-800004-
0001) for the Explorer 600+ is 
supplied for use in the field. 

 If the battery pack is lost, six AA 
batteries can provide power to the 
Explorer 600+ for approximately 2 to 3 
hours. If TruBlu™ wireless is being 
used, battery life is less.   
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 Battery Charging 

 The battery pack is shipped fully 
charged and installed in the Explorer 
600+. Some battery dissipation occurs 
during shipping. Charge the battery 
pack in the Explorer 600+ for 
approximately four hours before first 
use.  

1. Assemble the battery charger kit: 

a. Fit the input plug into the AC/DC adapter (see 
Figure 12). 

 
Figure 12: AC/DC Adapter Input Plug 

b. Plug the battery charger jack into the rear 
power connector on the female connector end 
of the charging cable (see Figure 13). 

 
Figure 13: Battery Charger/Charging Cable 

2. Connect the female connector end of the charging 
cable to the 9-pin male connector on the bottom 
of the Explorer 600+ (see Figure 14). 
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Figure 14: Explorer 600+ Charger Connection 

3. Plug the battery charger into an AC receptacle. 
The CHG LED on the Explorer 600+ front panel 
illuminates green (see Figure 15). 

 
Figure 15: CHG LED 

 The 9-pin male connector end of the 
charging cable is not used in this 
procedure. 

4. Charge the battery until the green CHG LED 
blinks (approximately four hours). 

5. Unplug the battery charger and disconnect the 
charging cable from the Explorer 600+. 

Verify functionality: 

6. Press the Explorer 600+ power button  to 
boot up the Windows CE desktop. The icon for 
Carlson SurvCE is on the desktop (see Figure 
52). 

7. Shut down Windows CE. Press and hold the 
Explorer 600+ power button for at least 10 
seconds.  
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 Battery Pack Installation and Removal 

The battery compartment door is on the back of the 
Explorer 600+.  

• Install the battery pack with the orange label face 
up. The label identifies the top and bottom of the 
battery pack. 

• Pull the cloth strip at the bottom of the battery 
pack to remove the battery pack. 
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Chapter 4 ..................Function Test Setup 

This chapter provides a test setup of the LAND-PAK 
before field operation to ensure system functionality. 
The function test setup involves:  

 Radio modem configuration 

 Hardware setup  

System inventory and battery charging must be 
completed before this test setup. Refer to Chapter 2 
Inventory Check and Chapter 3 Battery Charging. 

 The function test setup does not 
involve satellite communication. Refer 
to Chapter 5 SurvCE Software 
Operation for a quick start guide to 
initialize the system and start 
collecting computed positions in three 
dimensions. 

 NavCom male and female LEMO 
connectors feature a red dot for easy 
connection alignment. 
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Radio Modem Configuration 

This section provides steps to initially configure the 
LAND-PAK radio modems. Configuration is almost 
identical for both the base station and rover radio 
modems, differing only in RF power output settings. 

 Refer to the supplied Satelline-3AS 
user guide for additional information 
on radio modem configuration. 

 After the initial configuration, generally 
only the RF frequency and the base 
station RF power output settings need 
to be changed to accommodate job 
needs. These settings are generally 
changed using SurvCE software on 
the Explorer 600+ data collector. Refer 
to Chapter 5 SurvCE Software 
Operation. 
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Soft Keys 

 
Figure 16: Radio Modem Soft Keys 

By using the four soft keys below the LCD display, all 
configurable settings are accessible through on-
screen menus (see Figure 16). 

The function of each soft key, which varies depending 
on menu requirements, appears at the bottom of the 
LCD display (see Table 10).  

Table 10: Radio Modem Soft Key Functions 

Soft Key Function 

 

CANCEL/BACK/EXIT: Cancel changes. Go 
back to a previous screen. Exit the main 
menu. Upon exiting the main menu, a 
confirmation screen opens for saving or 
discarding changes to settings.  

UP/DOWN: Move through menus and  
options. Change numerical values. 

 

SETUP/SELECT/CHANGE/SET/NEXT:  
Setup the radio modem configuration –  the 
main menu opens. Select a menu or option. 
Change an option setting. Set changes. For 
numerical values, move to the next digit. 



 LAND-PAK™ User Guide – Rev. C 

4-62 

Operating Modes 

ansfer mode by 
default. Prog
radio modem

 Dat Tra

In data trans wer-up, 
the LCD display shows the operating settings of the 
radio modem, signal strength, and battery status (see 
Figure 17).  

The radio modems operate in data tr
ramming mode is used to configure the 
s. 

nsfer Mode 

fer mode, which appears at po

a 

 
Figure 17: LCD Display – Data Transfer Mode 

 Programming Mode 

Programming mode is accessed from the data 
 transfer mode screen. Press the Setup soft key. The

programming mode main menu opens (see Figure 
18). The cursor “>” indicates the active option. 

 
Figure 18: LCD Display – Programming Mode 
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Configuration 

The sections following provide steps to configure 
these radio menu items: 

 RF Frequency 

 RF Power Output (set for base station only) 

 Signal Threshold (set for rover only) 

Addressing Settings 

Serial Port Settings 

 

• Base Station Radio Modem:  

• The LAND-PAK LM configuration (3ASd 
Epic radio modem): There is no on/off 
switch on the 3ASd Epic radio modem. 
Connect the serial 15-Pin end of the 

 
connector on the bottom right of the radio 
modem. Connect the LEMO 2-Pin end to 

ag battery (see Figure 11).  

d 

e LAND-PAK 
nfigurations use the same 
Turn on the switch at the 

 

 

 

 Additional 

Handshaking 

Configure the base station radio modem. Then repeat
the configuration steps for the rover radio modem. 

1. Power on the radio modem:  

NavCom base cable to the female serial

the b

• The LAND-PAK 869 configuration (3AS
869 radio modem): Turn on the switch at 
the top of th  e battery. The red LED 

s. 

• Rover Radio Modem:  

illuminate

• The rover radio modems in th
LM and 869 co
type of battery. 
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top of th
illuminat

e battery. The red LED 
es.  

 During this initial configuration, the 
signal strength setting in data transfer 
mode is blank (see Figure 19). 

 
Figure 19: Data Transfer Mode 

 programming mode. Press the Setup soft 
e 

2. Acc ss
key e
sho  
ver n
app r

RF requ

e
 (s
ws
sio lly 
ea s (see Figure 18).  

any time during configuration, press 
Cancel/Back

Figure 19). The display temporarily 
the radio modem model and the firmware 
. Then the main menu automatica

 At 
the  soft ke
changes if necessary, t
previous scr

y to cancel 
o return to a 

een, or to exit the main 
menu. 

ency Configuration F

 nly to a 
licensed frequency. It must comply 
with local regulations.  

A label on both radios lists the i

Set the radio modems o

 nitial 
(center) frequency. The label is on the 
front of the base station radio. It is on 
the rear of the rover radio, above the 
battery. The frequency can be set 
within 1MHz of the center frequency, 
at 25KHz increments. 
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1. Press t equency 
from the mai
frequency of the active channel is displayed (see 

he Select soft key to select RF fr
n menu (see Figure 18). The 

Figure 20). 

 
Figure 20: Active Channel 

ss the C2. Pre hange soft key to e the 
displayed with 
 The first digit 

an

et uency: 

 cursor to 

  chang
ncy is 

he first digit.
c not be changed. 

 the radio modem to the licensed fre

Press the next soft key 

frequency. The center freque
a cursor pointing up to t

3. S q

a. to move the 
the next digit (see Figure 21).  

 
Figure 21: Next Digit 

b.  Press the up or down arrow soft key to 
change the value of the digit, if needed. 

c. Repeat steps a and b above for each 
configurable digit.  

When the cursor is at the last configurable 
digit, the Set option appears in the bottom 
right of the LCD display (see Figure 22). 
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Figure 22: Set Frequency 

Change the value of the last cod. nfigurable digit, 
if needed. 

e. Press the Set soft key to set the frequency 
changes. Or, press the Cancel soft key to 
cancel the changes. 

• If the frequency is set within the 
acce ation message 
is disp en the main 

e is 
mporarily. Then the main 

e 

• If the frequency changes are canceled, the 
display returns to the main menu. 

4. Continue to the next section, to configure the RF 
power output. 

RF Power O

modem e rover radio modem is being configured, 
go 

1. Pre sor 
Radio settings (see 

Figure 23). 

ptable range, a confirm
layed temporarily. Th

menu returns.   

• If the frequency is set outside the 
acceptable range, an error messag
displayed te
menu returns. No change is made to th
center frequency. Repeat the RF 
frequency configuration procedure to 
change the frequency. 

utput 

Perform this setting only on the base station radio 
. If th

to the next section below, Signal Threshold. 

ss the down arrow soft key to move the cur
down the main menu to 
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uFig

2. Press t . 
A subm

pt ,

re 23: Main Menu – Radio Settings 

he Select soft key to select Radio settings
enu is displayed with the cursor at the 

 TX level (see Figure 24). o ion

 
Figure 24: TX level option 

 soft key to change the TX level. 3. Press the Change
A submenu is displayed with RF power output 
settings. Figure 25 shows the RF power output 
settings for the 3ASd Epic radio modem (the 
LAND-PAK LM configuration). 

 
Figure 25: RF Power Output Settings 

ss the up or down

 
uses the 

4. Pre  
cur

• 3ASd Epic radio modem (the LAND-PAK LM 
configuration): The RF power output options 
are 1, 2, 5, or 10 watts. The 10 watt setting
provides the maximum range and ca

 arrow soft key to move the
sor to a desired RF power output.  
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maximum discharge on the battery. Select a 
lower setting for surveys over small areas.  

• 3ASd 869 radio modem (the LAND-PAK 869 
configuration): The RF power output options 
are from 10 mW to 500 mW. 

6. nu. 

Perform this setting only on the rover radio modem. If 
the base station radio modem is being configured, go 
to the section below, Serial Port Settings. 

Press the down arrow soft key to move the cursor 
e

5. Press the ower output. 
The display 
cursor at TX level. 

Press the Back soft key to return to the main me
Continue to the next section.  

Signal Threshold 

Set soft key to set the RF p
returns to the submenu with the 

1. 
dow  n the main menu to Radio settings (se
Figure 26). 

 
Figure 26: Main Menu – Radio Settings 

ss the Select soft key to select Radio setting2. e . Pr s
A submenu is displayed with the cursor at the 
op ion, TX level (see Figure 27). t

 
Figure 27: Sig. Threshold option 
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3. Press the down
down the main menu to 

 arrow soft key to move the cursor 
Sig. Threshold. 

using SurvCE and should cause optimum 
performance.  

5. Press the Set soft key to set the threshold level. 
The display returns to the submenu with the 
cursor at TX level. 

ss the Back soft key to return to the main

everything set to Off. 

Serial Port Settings 

1. Press the down arrow soft key to move the cursor 
down the main menu to Port 1 (see igu

4. Press the Change soft key to change the Signal 
Threshold level. A submenu is displayed with 
available negative dBm settings. 

a. Set the threshold to -116dBm. 

• This is equivalent to the Low threshold set 

6. Pre  
me

Addressing Settings 

The Addressing remains at factory default with 

nu. 

F re 28). 

 
Figure 28: Main Menu – Port 1 Setting 

2. 
b

sta  
the def

Press the Select soft key to select 
su menu is displayed. The cursor po

Port 1. A 
ints to the 

tus of Port 1. The default is ON. Do not change 
ault. 
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3. Press the down arrow soft key to move the curso
to the next setting on the submenu. It is for the 
currently set baud rate (see Figure 29).  

r 

 
Figure 29: Baud Rate Setting 

 soft key to change the baud 
rate. A submenu appears with a list of baud rates. 

5. Press the down arrow soft key to move the cursor 
to 38400 bit/s (see Figure 30). 

4. Press the Change

 
Figure 30: Baud Rate Setting Change 

6. Press the Set soft key to set the baud rate to 
38400 bit/s. The previous submenu returns with 
38400 bit/s listed as the current baud rate. 

 The SF-2040 GPS sensors’ RTK 
corrections com port will be configured 
to the same baud rate (see Figure 67).  

7. Press the Back soft key once to return to the main 
menu. 

8. Continue to the next section. 
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Handshaking 

The Handshaking menu functions remain at the 
default settings: CTS: Clear To Send, CD: RSSI, and 

S: Ignored. RT

Additional 

Error correction and error checking increase the 
reliability of data transfer via radio modem.  

The receiver sensitivity is bas  on the  
(

ed
channel spacing of the radio modem 
data rate of the radio interface) and the 

mode of the FEC (forward error 
correction) as indicated in the table 
below. This radio is typically operated at 
25 kHz channel spacing. 

Table 11: FEC Signal Thresholds 
Channel FEC Off  FEC On 
Spacing 
25 kHz  -110 dBm  -113 dBm 
20 kHz  -112 dBm  -115 dBm 

12.5 kHz  -112 dBm  -115 dBm 

 The setting for error correction must 
be the same on all radio modems that 
will communicate with each other. If 

ransmitting radio modem and the 
receiving radio modem have different 

e ursor 
e 

31)

the t

settings, data will not be received 
correctly. 

1. Pr ss the down arrow soft key to move the c
down the main menu to Additional (see Figur

. 
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Fi ain – Additional 

2. Pres ct el l.  

a. A  nts to 
E

Refer to 

3. Pre
ON

4. Pre  cursor 

gure 31: M Menu Setting 

s the Sele soft key to s ect Additiona

 submenu
rror corr. 

is Th

Figure 32 and Figure 33 for the steps b

ss the Change soft key to turn error cor
. 

ss the down arrow soft key to move the
wn the submenu to Error check. 

ss the Change soft key to turn error checking

displayed. e cursor poi

elow. 

rection 

do

5. Pre  
ON. 

 
Figure 32: Error Correction and Error Checking 

6. Press the down arrow soft key to move the cursor 
od

a

wn the submenu to SL-commands. 

On the both the base and rover radio, set  . 
SL-commands to ON by pressing the Change 
key. 



 LAND-PAK™ User Guide – Rev. C 

 4-73 

 
Figure 33: SL-Commands and Priority 

7. Press the down arrow soft key to move the cursor 
down the submenu to Priority. 

a. On the Base radio, set Priority o TX by  t
pressing the Change key. 

b. On the Rover radio, Set Priority to RX by 
pressing the Change key. 

 

it’s transmit state. However, the rover must 
not be receiving corrections from the base 
when attempting to program the rover via 
SurvCE. This may necessitate turning the 
base radio off during programming, or at 
minimum, removing temporarily the rover 
antenna (which may or may-not completely 
remove the base signal) 

8. Press the Back soft key twice. Save changes? is 
displayed (see Figure 34). 

The radio operates in Half-duplex (simplex) 
mode. The base radio can always be 
communicated with via SurvCE, regardless of 

 
Figure 34: Save Changes 
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9. Press the soft key to select the Yes option.  All the 
configuration changes are saved. The display 
returns to the setup screen. (see Figure 17). 

10. Perform one of the following steps: 

Repeat the sections above, except for 

r on 

B e 

This se
up the  
area fo

An out
transit 

• RF 
io 

• If both the base station and rover radio 
modems have been configured, verify 

Power Output, to configure the rover rad
modem. 

communication between the radios. ow
both radio modems. The CD

P e
 LED illuminates 

on both radios to indicate carrier detect.  

as Station Test Setup 

ction provides steps to correctly and safely set 
base station. It is important to select an open
r the test setup. 

door setup requires the transport of the base 
case and the base bag, both of which contain 
base station equipment. all the 

 
indoor carpets. 

Find a safe, open, and flat location t

The base station tripod leg points may 
damage soft materials, including 

1. o setup the 
base station.  

 
The following steps use equipment from the base 
bag: 

 
2. Unbuckle th

together. Store the strap in the base bag. 
e strap that holds the tripod legs 
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3. Open the tripod legs until the tripod is stable. Use 
the tripod leg levers and the tripod wing screws to 
adjust the height and secure the tripod (see 
Figure 35). Leveling the tripod by eye is suff ci ient.  

 
 

Figure 35: Base Station Tripod – Leg Adjustments 

 

rach 

 
Figure 36: Base Station Tripod 

Refer to Figure 36 for the steps below: 

4. Remove the tripod cap by unscrewing the trib
fastener.  
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Use the two Allen wrenches (4mm and/or 5mm, 
respectively) on the top plate of the tripod to 
tighten the hex screws at the top of the tripod if 
needed. 

5. Store the two Allen wrenches in the 
and discard 

base bag, 
the protective paper cover.  

 
Figure 37: Mounting Tribrach & Tribrach Adapter 

Refer to Figure 37 for the steps below: 

6. Mount the tribrach to the top of the tripod as 
follows:  

• Position the tribrach so it fits evenly on the top 
plate and is flat. 

• Screw the tribrach fastener into the tribrach 
until it is secure. 

 The tribrach has a leveling bubble a

down the knob on the side of the tribrach. 

nd 

7. Mount the tribrach adapter into the three holes of 
the tribrach, and then lock it in place by turning 

three adjustment knobs to make fine 
adjustments. 



 LAND-PAK™ User Guide – Rev. C 

 4-77 

 OPTIONAL STEP: Screw the pole 
extension into the tribrach adapter. The 
pole extension provides easier access to 
the connectors and exchange of the 
batteries on the SF-2040 GIS PM Sensor. 
The pole extension is in the base bag. 

 
 

Figure 38: Mounting the Radio Antenna Bracket 

Refer to Figure 38 for the steps below: 

8. Mount the radio antenna bracket to the tripod: 

a. Unscrew the rear knob of the bracket and 
remove the rear plate. 

b. Place the bracket against the opening on a 
tripod leg.  

 Do not mount the bracket to the tripod 
leg on which the shoulder strap is 
attached.  

c. At the back of the tripod leg, place the rear 
plate through the bracket screw.  
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d. Turn the knob onto the bracket screw until the 
bracket is secure. 

 

 

9. Lev

ensures that the radio an
when mounted. 

Over tightening may cause damage to 
the tripod leg finish. 

el the bracket by eye. Loosen the knob on t
side of the bracket to make the adjustment. This 

he 

tenna pole will be vertical 

 
 

Figure 39: Mounting the Antenna and Cable 

Ref

10. 

enna 
ada na pole. 

12. n of 

er to Figure 39 for the steps below: 

Screw the antenna adapter to the top of the radio 
antenna pole. 

Th
transit ca
 
11. Screw the radio modem antenna to the ant

pter on the top of the radio anten

e following steps use equipment from the base 
se: 

Co nect the straight male TNC connector end 
the RG58/U radio antenna cable to the bottom of 
the antenna adapter. 
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13. Extend the radio antenna pole to the maximum 
height possible.  

n

 Extending the radio antenna pole 
increases the radio modem range, 
isolates the sensor sig als from the 
radio modem, and avoids radiation 
hazard. 

 ation hazard when 
performing a survey, user and 
bystanders’ heads must be more than 
25cm (10 inches) away from the 
transmitting antenna (see Figure 40).  

To avoid radi

 
Figure 40: Avoiding Radiation Hazard 

14. Screw the radio antenna pole onto the round 
ounting m plate of the radio antenna bracket (see 

Figure 38). Make sure that there are no 
obstructions overhead. 

15. Attach the bag bracket to the 3ASd EPIC radio 
bag (the LAND-PAK LM configuration). The bag 
bracket is in the base transit case below the 3ASd 
EPIC radio modem.  
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 The LAND-PAK 869 configuration: the 
bag bracket is already attached to th
3ASd 869 radio modem bag. 

e 

 
 

Figure 41: Mounting the Radio and Bag Battery  

Refer to Figure 41 for the steps below: 

16. Using the strap and the bracket on the radio bag, 
mount the radio modem to the tripod leg above 
the radio antenna bracket. 

 LAND-PAK LM configuration only:  
12V 8Ah bag battery in a safe and secure posit

17. The  Hang the
ion 

EPIC radio modem.  

 Connect the right angle male TNC connector end 
of the radio antenna cable to the top 
TNC connector of the 3ASd EPIC rad

on the tripod, within easy access of the 3ASd 

18.
left female 
io modem 

(see Figure 42). 

 The TNC connector on the right 
(above the display) is used for 
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diversity receive only, which is not 
used in this application. Connecting to 
this port will prevent RTK corrections 
being broadcast to the rover. 

 The LAND-PAK 869 configuration:
The 3ASd 869 radio modem has only 
one female TNC connector on the top. 

 

 
 

Figure 42: Mounting Cable to the Radio Modem 

19. Insert the two lithium-ion 
battery packs into the SF-
2040 GIS PM Sensor. 
Refer to Chapter 3 Battery 
Charging for details on 
battery pack installation.  

0.

 

2  Screw the sensor onto the 
antenna pole extension, if 
mounted, or onto the 
tribrach adapter. When 
securing the sensor, make 
sure that the front display 
faces the radio modem for 
easy access. 

Figure 43: 

 

Mounting Base SF-2040
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COM2

 
Figure 44: NavCom Base Cable Connections 

Refer to Figure 44 for the steps below: 

. Connect the NavCom se cable (the L ND-PAK 

in end of the cable to 
ctor on the bottom 
.  

n end of the cable to 
GIS PM Sensor. 

connector end 
in this 

figuration: 
cable to 

3ASd 869 radio modem to 
COM 2 of the SF-2040 GIS PM 
Sensor. 

22. This concludes
Carefully, disassemble t
repack all the equipment into the base transit 
case and base bag. 

 

 

21

•

 ba A
LM configuration): 

 Connect the serial 15-P
the female serial conne
right of the radio modem

• Connect the LEMO 7-
COM 2 of the SF-2040

Pi
 

 The LEMO 2-Pin power 
of the cable is not used 
procedure.  

 The LAND-PAK 869 con
Use the NavCom DB-9 
connect the 

 the base station test setup. 
he base station, and 
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Rover Test Setup 

This section provides the steps to correctly and safely 
set up the rover. It is important to select an open area 
for the test setup. 

An outdoor setup requires the transport of the rover 
transit case and the rover bag, both of which contain 
all the rover equipment. 

 The outer section of the rover pole is 
carbon fiber. The inner extension is 
aluminum, with dual graduations in 
feet and meters. 

 The rover pole and bipod leg points 
may damage so ft materials, including 
indoor carpets.  

 Over tightening attachment
carbon fiber of the rover pole may 

s to the 

cause damage. 

 The bipod is intended to make 
installation easier, but it is not as 
stable as a tripod. 

d a safe, 1. Fi open, and flat location to setup the 
rover.  

lowing steps use equipment from the rover 

n

 

d 

3. 
gs. 

The fol
bag: 
 
2. Remove the strap that holds together the bipo

legs. Store the strap in the rover bag. 

Position the bipod upright on the floor or ground. 
Do not open the bipod le

 



 LAND-PAK™ User Guide – Rev. C 

4-84 

 
u

Re r t

4. 
op

5. Pla

Fig re 45: Mounting the Rover Pole to the 

o Figure 45 for the steps below: 

Loosen the clamping kn

Bipod 

et and 

fe

ob in the bracket at the 
t  of the bipod. 

ce the rover pole vertically in the brack
tighten the knob. Do not over tighten.  

 
Figure 46: Rover Pole and Bipod 
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Refer to Figure 46 for the steps below: 

6. Adjust the rover pole and bipod assembly: 

a. Pivot the bipod legs out. 

b. Adjust the height of the bipod legs. With the 
leg points on the floor or ground, press the 
bipod thumb releases and lift up. At the 
desired height, release the thumb releases. 

 If the bipod legs are suspended when 
the thumb releases are pressed, the 

l 

legs drop quickly, and the leg points 
may cause damage. 

c. Adjust the rover pole and bipod assembly un
it is stable. It 

ti
does not have to be level.  

 
Figure 47: Mounting the Carlson Explorer 600+ 

Refer to Figure 47 for the steps below: 

7. Mount the cradle for the Carlson Explorer 600+: 

• Loosen the knob on the small cradle clamp. 

• Mount the small cradle clamp to the carbon 
fiber section of the rover pole, near the top 
bracket. The rover setup is mo  stable if the re
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radio modem and Carlson Explo
bipod legs by shifting the offset 

rer bise
weight t

same side as the bipod legs. Tighten th

ct the 
o the 
e 

. 

Th
tra

8. Mo
la

600

knob. Do not over tighten

e following steps use equipment from the rover 
nsit case: 

unt the Carlson Explorer 600+ to the crad
mp below the LCD display. Verify the Explore

le 
r c

+ is secure.  

 
Figure 48: Mounting Radio Modem 

Refer to Figure 48 for the steps below: 

9. Screw the radio modem antenna to the female 
TNC connector on the top of the 3ASd radio 
modem. 

10. 

t 
t

11. s
SF
Bat

Using the strap and the clamp on the radio bag, 
mount the 3ASd radio modem to the rover pole 
below the Carlson Explorer 600+ cradle. The 
rover setup is more stable if the radio modem 
bisects the bipod legs by shifting the offset weigh
to he same side as the bipod legs. 

In ert the two lithium-ion battery packs into the 
-2040 GIS PM Sensor. Refer to Chapter 3 
tery Charging for details. 
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12. Scr
sec
dis

ew the sensor onto the rover pole. When 
uring the sensor, make sure that the front 

play faces the radio modem for easy access. 

 
Figure 49: NavCom Rover Cable Connections 

Refer to Figure 49 for the steps below: 

13. Connect the NavCom rover radio modem cable: 

• Connect the serial 9-Pin end of the cable to 
the female serial connector on the bottom of 
the radio modem. 

• C  

e 

onnect the LEMO 7-Pin end of the cable to
Sensor. 

14. Extend the aluminum extension of the rover pol
to the maximum height possible.  

COM 2 of the SF-2040 GIS PM 

 

 

COM2
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Figure 50: Rover Pole Knob and Locking Pin 

Refer to Figure 50 for the steps below: 

15. Tighten the rover pole knob to secure the pole 

nsit case and 
rover bag. 
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extension. If extended to 1.8 m, 2 m, or 2.2 m, 
also insert the attached locking pin i
extension hole.  

nto the 

 Extending the rover pole isolates the 
sensor signals from the radio modem. 
And reduces the possibility of satellite 
signal bloc age byk  passing 
pedestrians or vehicles. 

This concludes the rover test setup. Carefully, 16. 
disassemble the rover attachments, and repack 
all the equipment into the rover tra
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Chapter 5 ......SurvCE Software Operation 

This chapter provides an introduction to the basic 
operation of the LAND-PAK using Carlson SurvCE 
Software on the Explorer 600+ data collector. After 
the system is set up as described in Chapter 4 
Function Test Setup, follow the Getting Started 
section which follows to initialize the system and 
begin collecting measured positions in three 
dimensions.  

The settings in this chapter are suggested for a 
typic

t 

he 
e 

ct 
o the 

 

Fil

urvCE creates a number of files for supporting a 
roject in the field. Two primary files are created to 

manage each project. The coordinate file appended 
with .crd contains the measured or computed 
coordinates for the job, and the raw data file 
appended with .rw5 contains the survey 
measurement details. 

al RTK survey, in which: 

 The base receiver is setup on an unknown poin

 A navigation position in WGS84 is assigned to t
base point to support real time positioning in th
satellite coordinate system 

A coordinate syst em is established for the proje
by assigning an assumed grid coordinate t
base point 

Refer to the supplied Carlson SurvCE 
manual for additional information. 

Overview 

e Types 

S
p
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File Management     

The Carlson X-Port utility is an office application used 
to convert files and communicate with the Explorer 
600+ as described in Chapter 6 Data Transfer. Text 
files containing coordinates can be converted to a 
.crd format and transferred to or from the Explorer 
600+. A geoid file can be created and transferred to 
the Explorer 600+.   
 
SurvCE Window Icons 

Table 12: SurvCE Window Icons 
Icon Description 

 

Hot List Menu – Tap the icon to access help 
and other menu options. The options vary 

n the SurvCE window that is 
open. 
depending o

 Accept 

 Cancel 

 Return 

 Battery Status 

 
GPS Base Mode – Tap the icon to access 
the mode menu, which includes the options, 
GPS Rover mode and GPS Simulation. 

 
Map View – Toggle between the open 
window and Map View. 
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Getting Started 

Create A New Job 

 
Figure 51: Coiled Serial Cable 

1. For this initial operation of the LAND-PAK, 
connect the Explorer 600+ controller to COM1 
(the LAND-PAK control port) of the base station 
SF-2040 GPS sensor. Use the supplied 6 ft. 
coiled serial cable (see Figure 51). 

 If wireless connectivity is desired in 
the future, refer to Appendix C for the 
configuration of the TruBlu™ module. 

 
Figure 52: Desktop with SurvCE Icon 

Female 9-Pin
  

Connector 
SerialLEMO 7-Pin 

Connector
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2. Boot up the Explore
Figure 52). 

r 600+ desktop (see       

3. Double tap the SurvCE icon on the Explorer 600+ 
desktop. The SurvCE job selection box opens in 
front of the main menu (see Figure 53).  

 
Figure 53: SurvCE Job Selection Box 

the Sel4. Tap ect New/Existing Job button to create 
a new file (job). The Coordinate Files window 
o e igure 54).  

 e > Job to access the 
Coordinate Files window from the 

 

p ns (see F

Select Fil

main menu.

 
Figure 54: Coordinate Files Window 
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5. Create a new c
in the Name

oordinate file. Enter the file name 
 field. Tap  to save the file. The 

appended automatically.  

Coordinate files are stored in the 
\SystemCF\Data folder to avoid data 
loss in case of a system failure.  
Folders may be created for organizing 
jobs.  

 Points are st
a search for poin
ks in 

depending o

.crd extension is 

 

ored in coordinate files
ts, SurvCE

a *.crd file. Then, 
n settings, looks in a 

.  
 During 

first loo

desi

Job Settings 
gnated control file. 

 
Figure 55: File Menu – Job Settings 

1. Select File > Job Settings to configure data 
collection options that will remain set from job to 
job (see Figure 55). The Job Settings submenu 
opens (see Figure 56). 
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2. Check the Prompt for Units option to be prom
at the start of a new job to set the units for the job
(see Figure 56

pted 
 

).  

 
Submenu – New Job Tab Figure 56: Job Settings 

 Figure 57 for the steps below: Refer to

3. Tap the System tab. 

 
Figure 57: Job Settings Submenu – System Tab 

4. Select the appropriate settings:  

• Distance: Set the units to be used on a job, 
US Feet, International Feet, or Metric. If US 
Feet or International Feet are selected, set the 
units as Decimal Feet or Feet and Inches 
(Inches).  
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 Distance is a display property only. It 
does not change the format of the 
data recorded to the raw file. 

• Angle: Set degrees (360 degree circle, 
seconds to a minute, 60 minutes to a d
or gons \ grads (a 400 unit circle fully 
decimal). In other words, an angle of 
397.9809 gons is equivalent to 358 d

0 min

60 
egree) 

egrees, 

e, 

imuth Setting: Select the direction for 
North or South. 

• Projection: Select a coordinate projection for 
the area of the survey from the drop-down list. 
If the needed projection is not in the drop-
down list, tap the Edit Projection List button. 
The Coordinate Projection window opens (see 
Figure 58).  

1 utes and 58 seconds.  

 The Angle setting affects commands 
where a direction is displayed or 
entered, such as Inverse, Travers
Sideshot, Input-Edit Centerline. 

• Zero Az
zero azimuth, 

 
Figure 58: Coordinate Projection Window 
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Add a predefined or user defined coordinate 
projection. Tap the arrow button in the top right of 
the window. The System tab returns with the 
added projection selecte

Refer to Figure 59 for the steps belo

5. Tap the Format tab. 

d in the drop-down list. 

w: 

 
s Submenu – Format Tab 

6. Select the appropriate settings.  

 Angle Entry and Display: This option 
applies to numerous commands, such 
as prompting and displays in Sideshot 
Traverse, Intersections and Inverse. 

 Distance Observation Display and 
Slope Entry and Display apply to total 
stations. 

 

 

 

Figure 59: Job Setting
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Refer o Figure 60 for the steps below: 

7. Ta  the Options tab. 

t

p

 
Fig ptions Tab 

Check only the options listed below. De-select all 
er options.  

u

8. 
h

• 

n of the measurements. 

• Use Code Table for Descriptions: Refer to the 
Carlson SurvCE manual for instructions. This 
option is useful for assignment of attributes 
and controlling how features are plotted. 

 Check the Use Control File option to 
access points in a file imported to the 
Explorer 600+ controller to support the 
job. The Select File button becomes 
active. Tap the button. The Coordinate 
Files window opens. Select the 

re 60: Job Settings Submenu – O

ot

• Time Stamp Each Point: Saves a date/time 
stamp in the raw data file (*.rw5). 

Store GPS Accuracy in Raw File: Saves the 
horizontal and vertical RMS in the raw file and 
in the note field. This data provides a record of 
the precisio

necessary control file. 
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ight contain the 
cord boundary 

coordinates for a survey to be retraced 
or points to be staked for construction.  

Another met
ASCII/Text f
Then use th
Import/Export
convert the text file to a .

Refer to Figure 61 for the steps belo

9. Tap the Stake tab. 

 To create a control file, convert a text 
file to a *.crd file in the X-Port utility. 
Then use the utility to import the file to 
the Explorer 600+. Refer to Chapter 6 
Data Transfer. 

The control file m
calculated re

hod is to transfer an 
ile to the Explorer 600+. 
e command, File > 

 > Import ASCii File, to 
crd file. 

w: 

 
Fig b Settings Submenu – Stake Tab 

0. Check only the options: 

• Store Data to Note File: Stores the stakeout 
data in the note file (*.not) for the current job.  

 At the end of staking out a point, there 
is an option to store the staked 

ure 61: Jo

1
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coordinates in the
files are associated with 

 current job. Note 
points, so the 

point must be stored to also store the 
cutsheet note. This additional data 
includes the target coordinates for 
reference. Keep in mind that the cut 
and fill data is also stored in the raw 
file, plus an ASCII cutsheet file can be 
stored using the button at the bottom 
of the Stake tab, so storing into the 
note file is somewhat re

• Control File Points have 
Check this o

dundant.  

Priority for Stakeout: 
ption if the points to be staked 

were loaded as a separate file and designated 
as a control file. 

GPS Base Setup 

 
Figure 62: Equip Menu – GPS Base 

ect Equip > GPS Base to configure the 
se for RTK/Static surveys (see Figure 62
S Base submenu opens (see Figure 63)

1. Sel GPS 
Ba ). The 

P .  G
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2. At t
Na

he Manufacturer drop-down list, select 
vCom (see Figure 63). 

 
urrent Tab 

. View this tab to gain 
awareness of the options. Do not change any of 
the default settings (see Figure 64). 

 If wireless connectivity is desired in 
the future, refer to Appendix C, TruBlu 
Configuration for the appropriate 
wireless Comms tab settings. 

Figure 63: GPS Base Submenu – C

3. Tap the Comms tab

 
Fig Tab 

 

ure 64: GPS Base Submenu – Comms 
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Refer t

4. Tap

o Figure 65 for the steps below: 

 the Receiver tab. 

 
bmenu – Receiver Tab 

5. Set the options: 

• Antenna Type: [NAVCOMSF2040G] GIS 

• Antenna Height: Enter the height in the 
current job units, and select Slant. Take the 
slant height measurement at the center of the 
black ring around the top of the receiver.   

 If working in feet, the height can be 
checked by measuring in meters. Tap 
the Antenna Height field. Enter the 

this angle, no data will be transmitted to the 

Figure 65: GPS Base Su

h

c

eight in meters, for instance 2.000m. 
Tap outside the field. The meters are 
onverted to feet. 

• Elevation Mask: Enter the cutoff vertical angle 
above the horizon. For any satellites below 

rover for use in calculating positions. 

 The recommended setting for the 
base receiver is 5 degrees; however, 
the height of on-site obstructions will 
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dictate this setting. Collecting poor 
data (i.e. through trees) at the base 
will unknowingly degrade the 
performance of the rover.  

• Position Rate: The position update rate to 
transmit the position to the rover. Keep the 1 
Hz default. It displays one reading per second. 
(The 5 Hz setting is 5 times per second.) 

 USER Antenna Suggestion: Create a 
USER antenna type so that the slant 

the height above the NGS calibrated Antenna 
Reference Point (ARP) called the SHMP, and 
the L1 and L2 Phase Center height above the 
ARP (see Figure 66). Tap 

height measurement can be taken at 
the bottom of the battery casing which 
is coincidental with the Antenna 
Reference point (ARP) as shown on 
the NGS Antenna Models web site. 

Tap the List button on the Receiver t
Figure 65). The Define Antenna window
opens. Tap New and the next available
antenna is displayed. Enter in the
and parameters for the Radius

ab (see 
 

 USER 
 Description 

 from center, 

.   

 
R Antenna Type Figure 66: USE
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Refer to Figure 67 for the settings b

6. Tap the RTK tab. 

elow: 

 
iF

7. t

mbers to 
 rover 

tical ID or 
ble 

p

gure 67: GPS Base Submenu – RTK Tab 

Se  the options: 

Device: Satel 

Baud: 38400 

• 

• 

• Base ID: Enter any combination of nu
create a unique base ID, if desired. The
radio modem must be set to the iden
0 to accept corrections from any availa
reference station.  

The ID isolates the base  and rover 
radio modems. It avoids cross talk 
between the rover radio modem and 
any other base radio modems in the 
area that may be set to the same 
frequency.  

8. Ta  the  button on the RTK tab.
nfigure Satel Radio window opens (se
.  

 The 
Co e Figure 
68)
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Figure 68: Configure Satel Radio Windo

o Figure 68 for the settings below: 

 the power and channel (frequen

w 

Refer t

9. Set cy) options for 
the

• 

• e ND-PAK 869 
configuration): The RF power output options 
are from 10 to 500 mW. 

10. Set the Squelch to Low (recommended).  

11. Tap 

 base radio modem as needed.  

3ASd Epic radio modem (the LAND-PAK LM 
configuration): The RF power output options 
are 1, 2, 5, or 10 watts. The 10 watt setting 
provides the maximum range and causes the 
maximum discharge on the battery.  Select a 
lower setting for surveys over small areas.  

3ASd 869 radio modem (th LA

 to accept the settings. The GPS Base 
submenu returns (see Figure 67).  

12. Tap  to accept all the settings made on the 
tabs of the GPS Base submenu. The Base 
Configuration window opens (see Figure 69). 

13. Continue to the next section to assign a geodetic 
position to the base station for computing elative  r
GPS positions between the base and rover. 

 



 LAND-PAK™ User Guide – Rev. C 

 5-105 

Assign a Base Position 

 
Figure 69: From New Position Options 

14. Tap the Read From GPS button. The Average 
GPS window open

 
s (see Figure 70). 

m GPS option is often 
used on a new project using a local 
coordinate system.  

The Read Fro

 
Figure 70: Average GPS Window 

Enter the number of autonomous navigation 15. 
solutions to be averaged at the base receiver. 

 A navigation solution is basically a 
resection from the satellites. If the 
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base has not been operating for 
several minutes with the GPS LED 
illuminated green, it is recommended 
to continue collecting data for one 
minute or more. This will result in a 
seed position for the base usually 
better than 10 feet. If the WAAS 
correction is being received the 
position will etter than 3 
feet. If a Starfire correction is being 
received the position will approach 0.3
feet after 30-45 minutes. When 

.

usually be b

 

working in a local coordinate system 
(not SPC) it is not necessary to kn
the precise geodetic position.     

ow 

16  Tap  to accept the settings. An average of the 
number of positions is taken. The Base 
C nfiguration window opens to display the 

ition (see Figure 71).  
o

pos

 
Figure 71: Base Configuration Window 

 Tap the Yes button to continue with the base 
setup. Tap the No button to return to the previ

17.
ous 

screen to change the number of autonomous 
navigation solutions to be averaged at the base 
receiver. 
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18. Save the job. If desired
save the position in a re

, select the option to also 
ference file (*.ref). The 

reference file will be available for recall on 
subsequent surveys.  

 Refer to Appendix B, Additional Base 
Position Options, for additional options 
to select when assigning a base 
position.  

Verify GPS Base Setup 

Verify the base setup. From the main menu, 
EQUIP > GPS Utilities. On the

s a 
to 

mplete.  

20. 

Appendix D Static Data Collection provides 
instructions for static data collection, which involves 
two basic steps: 

 Collect static observations for post-processing to 
compute a static network tie. For example, this 
might involve computing a position from CORS 
using the NGS OPUS process.  

Download a static data file after the desired 
d collection period. 

c e the user 
n AND-PAK.  

19. 
select 
that re i
prob fer 
the supplied Carlson Explorer 600+ user manual 
for further information. 

 submenu 
 opens, tap the Check RTK button. If the
lem, an error message is displayed. Re

The GPS Base Setup for RTK Surveys is co

Continue to the next section. 

Static Data Collection 

 
elapse

1. 
Collect Static Data section of Appendix D.  

Do not download a static data file. The base GPS 

Collect static data. Perform the steps in the 

re eiver will collect and store data whil
co tinues with this initial setup of the L
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2. Aft tatic 
Dat e next 
sec

GPS R

1. Do 

2. Dis e GPS.  

a. coiled 

• 

er completing the steps in the Collect S
a section of Appendix D, continue to th
tion, GPS Rover Setup. 

over Setup 

not exit SurvCE.  

connect the Explorer 600+ from the bas

Remove the LEMO 7-Pin end of the 
serial cable (see Figure 51) from COM1

Do not remove the female 9-pin serial 
connector end of the cable from the E
600+.  

Connect the Explorer 600+ to the rover GPS.  

.  

xplorer 

3. 

a. Connect the LEMO 7-Pin end of the coiled 
serial cable to COM1 of the rover GPS. 

 
Figure 72: Equip Menu – GPS Rover

 

 

 

4. Sel GPS 
). The 

GPS Rover submenu opens (see Figure 73). It 
has four tabs similar to the GPS Base submenu.  

ect Equip > GPS Rover to configure the 
Rover for RTK/Static surveys (see Figure 72
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5. At the Manufacturer drop-down list, select 
NavCom (see Figure 73). 

 
Figure 73: GPS Rover Submenu – Current Tab 

Tap the Comms tab. View this tab to gain 
awareness of the options. Do not change any of 
the default settings (see 

6. 

Figure 74). 

esired in 
ix C, TruBlu 

the appropriate 
wireless Comms tab settings. 

 If wireless connectivity is d
the future, refer to Append
Configuration for 

 
Figure 74: GPS Rover Submenu – Comms Tab 

 



 LAND-PAK™ User Guide – Rev. C 

5-110 

Ref

7. 

er to Figure 75 for the steps below: 

Tap the Receiver tab. 

 
Figure 75: GPS Rover Submenu – Receiver Tab

S

 

8. t

• 

 If preferred, create a USER antenna 
type so that the slant height 
measurement can be taken at the 
bottom outside edge of the battery 
casing on the SF-2040 which is 
coincidental with the Antenna 
Reference point (ARP) per the NGS 
Antenna Model. Refer to the GPS 
Base Setup section above for 
instructions on how to create a USER 

ntenna.  

If working in feet, the height can be 
verified. Tap the Antenna Height field. 
Enter the height in meters, for 

e  the options: 

Antenna Type: [NAVCOMSF2040G]   

a

• 
current job units, and select Slant. Take the 
slant height measurement at the center of the 
black ring around the top of the receiver. 

 

Antenna Height: Enter the height in the 
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instance 2.000m. Tap outside the 
field. The meters are converted to 
feet. 

 The correction for a 5 foot slant to 
vertical measurement to the bottom 
outside edge of the battery case on 
the SF-2040 is 0.01 feet. 

• Elevation Mask: Enter the cutoff vertical angle 
above the horizon. For any satellites below 
this angle no data will be processed at the 
Rover for use in calculating positions. 

 The recommended setting for the 

• Position Rate: The position update rate to 
read the position of the rover. Keep the 1 Hz 
default. It displays one reading per second. 
(The 5 Hz setting is 5 times per second.) 

 Set the Position Rate on the rover 
identical to the setting on the base. 
Doing so, reduces post-processing 
complexity. The position rate may be 
set to 10 seconds (for example) and a 
short static session, then reset to 1 

collection. 

n
rover receiver is 15 degrees. If it is 

ecessary for the rover to connect to 
more satellites, its elevation mask can 
be set as low as the Base. However, 
the lower setting may result in more 
noise and less accurate positioning. 
Be aware that solid obstructions will 
block a signal, and foliage will 
attenuate a signal resulting in 
degraded position quality. 

second and continue with RTK data 
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Refer to Figure 76 for the steps below: 

9. Tap the RTK tab. 

 
Figure 76: GPS Rover Submenu – RTK Tab 

10. Set the options: 

• Device: Satel 

• Baud: 38400 

• Base ID: If a Base ID is assigned to 
station, enter the exact same ID, or 
will not receive transmissions. 

Use Any Base ID: If desired, check th
to permit the rover radio modem to rec
communications from any available ba
is transmitting on the same frequency. 

p the 

the base 
the rover 

• is option 
eive 
se that 

11. Ta  button on the RTK tab.  

 12.
g
v
e
t

 The Configure Satel Radio window opens (see 
Fi ure 77). Set the Channel frequency for the 

er radio modem as needed. Set the Squelch to 
dium or High to maintain the best correction 
a integrity. 

ro
M
da

 Do not change the RF power output, 
as the rover is not transmitting.  
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Figure 77: Configure Satel Radio Window 

13. Ta  p  to accept the settings. The GPS R
submenu returns (see Figure 76).  

 

over 

14. Tap  to accept all the settings made on t
s of the GPS Rover submenu. The Surv
in menu returns (see Figure 72). 

GPS Rover Setup 

ify the rover setup. From the main me
ect EQUIP > GPS Utilities. On t
t opens, tap the Check RTK bu

problem, an error message will be di

he 
tab CE 
ma

Verify 

15. Ver nu, 
l
a a 

 
a

x D 
 

 

16. 

se he submenu 
th tton. If there is 

splayed. 
Refer to the supplied Carlson Explorer 600+ user
m nual for further information. 

PS Rover Setup is complete. 

Do not perform static data collection for the rover 

The G

GPS. If desired in the future, refer to Appendi
Static Data Collection for instructions.  

Static data is collected at the rover for 
post processing to obtain a greater 
precision than RTK or when outside 
the radio range of the base 

Continue to the next section. 
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GPS Utilities 

This section provides an awareness of utilities to 
 reset the GPS. check RTK operation or

 
Figure 78: Equip Menu – GPS Utilities 

1. lSe ect Equip > GP
GPS Utilities wind

S Utilities (see Figure 78). The 
ow opens (see Figure 79). 

The available GPS utilities depend on 
the capabilities of the GPS. If a 
StarFire™ license is not active, the 
Quickstart button is not available. 

 

 
F ons 

 

igure 79: GPS Utilities Submenu Opti
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Refer to Figure 79 for the options below: 

2. Select an option, as necessary: 

• Configure RTK Device: Configure the power, 
channel and squelch on the Satel radio 
modem (see Figure 68). This option is the 
same as RTK Configure in the base and rover 
setups above. 

• Check RTK: Determine if the receiver is 
operating properly. If there is problem, a 
message is displayed.   

0 

of the 
e as cycling the 

ars: 

o the 

• 
Qu
Quickstart (StarFire™ Only): Perform a 

ickstart from a previously saved ITRF 200
position.  

 Starfire™ corrections often take some 
time to acquire high levels of 
accuracy. If the user plans to return to 
a previously surveye
can save time by storing a known 

d area, the user 

position to a reference file (*.ref). Then 
the user can initialize the Starfire 
system with this position upon 
returning to the site by performing a 
Quickstart.   

• Reset Receiver: Perform a soft reset 
GPS receiver. This is the sam
front panel power switch. 

• Factory Reset: Reset the GPS receiver to 
factory defaults. A warning message appe
“Drastic measure, will take 15 minutes to 
recover.”  

Power On Receiver: Does not apply t
NavCom SF-2040 receiver.  

• 

3. Continue to the next section. 
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Monitor/Skyplot 

satellite status. 

This section provides an awareness of the SurvC
submenu to monitor the status of the GPS solutio
quality of the position, dilution of prec

E 
n, 

ision, and 

 
Figure 80: Equip Menu – Monitor/Skyplot 

Select Equip > Monitor/Skyplot (see Figure 801. 
Monitor/Skyplot submenu opens (see 

81 . 

). 
The Figure 

)

 
Figure 81: Monitor/Skyplot Submenu – Quality 
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The Quality tab provides (see Figure 81): 

• Status: 

• Autonomous: No radio communication 
between base and rover. Accuracy <10 feet 
usually. 

Float: Communication has been established, 
but ambiguities

• 
 have not been resolved. 

• Fixed: Position has been resolved.  Accur
at the centimeter level, more or less.   

Satellites: The number of satellites in radio 

acy 

• 

R
e

  

• The e 
geo e 
sol
Ver sition 
(PD me 
(G

e d 
o

 

 

 

 

communication. 

MS (Horizontal Root Mean Square) and VRMS 
rtical Root

• H
(V  Mean Square): Indications of the 
precision, not the accuracy, of the solution.

 Dilution of Precision (DOP) indicates th
metry of the satellites with respect to th

ution for the Horizontal Position (HDOP), 
tical Position (VDOP), 3 Dimensional Po
OP), Time (TDOP), and Position and Ti

DOP). Generally, a PDOP of 5 or less is 
ferred. A minimum of 5 satellites are r
btain a moving RTK solution an

pr equire
to d a minimum 
of 4 are required to maintain the solution with an 
acceptable PDOP.   
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2. Tap the Positio
and status of

n tab to view the current position 
 the GPS receiver (see Figure 82). 

 
enu – Position 

 tab to view the spatial 
e constellation above the 

Figure 82: Monitor/Skyplot Subm

3. Tap the SATView
orientation of the satellit

rizon (see Figure 83). The cross-hairs i thho n e 
ce
position relative to the satellites from a zenith 
view-point. 

nter of the display represent the receiver’s 

 
Figure 83: Monitor/Skyplot Submenu – SATView 
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4. Tap the SATInfo tab to view the pseud
number (PRN), the azimuth (AZI), and the 

o-ran

n (ELV) of each satellite above the 
horizon. This information is helpful to identify 
sa ellite locations relative to obstructions (i.e., 

es). 

ge 

t

elevatio

tre

 
Figure 84: Monitor/Skyplot Submenu – SATInfo 

Continue to the next section. 

nfigure 
5. 

Co

 
Figure 85: Equip Menu – Configure 

. Select Equip > Configure to configure options that 
apply to observations taken in the field (see 
Figure 85). These options remain set from job to 

1
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job. The Configure submenu opens (see Figure 
86).  

 The Sets tab is not applicable to GPS. 
The Receiver and RTK tabs are 
provided on the 
as a convenience. They are the same 
as the Receiver
described in
GPS Rover 

Configure submenu 

 and RTK tabs 
 the GPS Base Setup and 
Setup sections above.  

 
Figure 86: Configure Submenu – General Tab 

Refer to Figure 86 for the step below: 

2. Check only the options listed below. De-select all 
other options.  

• Store Fixed Only (GPS): Assures a centimeter 
position. Only data gathered in the Fixed 
(locked) status will be stored to the point file. If 
an attempt is made to store data when the 
receiver is not fixed, this message appears: 
Position is not fixed! Continue storing? Select 

• Prompt for Height & Description: Activates a 
window to open after each shot to enter the 
target height and description.  

 
Yes, No, or Store when fixed. 
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• Prompt for Point Notes: Activates the Notes
window to open after collecting a point to 
enter a point note.  

 A regular point consists of a point ID 
(number or alphanumeric), northing, 

 

easting, elevation, and description (up 
to 32 characters). Point Notes are a 
way to add an unlimited number of 
lines of text to a point. The notes are 
stored in a file with the same name as 
the coordinate file, but with a .not 
extension. For example, 
topo.crd would have a note file ca
topo.not.  

• 3D Mode: Activates 3D mode. If this option is 
not checked,
all elevations

a job called 
lled 

 2D mode is active. In 2D mode, 
 are stored as 0.0.   

Refer to Figure 87 for the steps below: 

3. Tap the View Pt tab. 

 
Figure 87: Configure Submenu – View Pt Tab 
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4. 

ethod: The desired direction and or
for moving the rover to a stake out poin

• Ref. Object: Instrument  

Directions From: Rod 

nces 

Select the settings: 

• M ientation 
t. 

• 

Tolera

 
Figure 88: Equip Menu – Tolerances 

1. Select Equip > Tolerances to set tolerances for 
data collection (see Figure 88). If the established 

Th
tolerances are exceeded, a warning is displayed. 

e Tolerances submenu opens (see Figure 89).  

 
Figure 89: Tolerances Submenu Options 
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2. t

This section arlson 
SurvC ts) and 
stakeo

 Sto

Store P tine for 
GPS e

 Sto ngs, 
cl

 e

y be stored using a text 

En er appropriate tolerances for HRMS, VRMS, 
and Stakeout (see Figure 89 for examples).  

Survey Menu (Measuring Point Positions) 

 provides guidance on the use of C
E to measure point positions (Store Poin
ut selected points. 

re PTS 

oints is the principle data collection rou
quipment (see Figure 90).  

re Points interacts with numerous setti
uding the feature codes, and draws lin

 Store Poi

in e work.  

Th nts window in GPS shows the 
cursor moving on the screen in real-time. The 
sc een pans automatically to keep the user 

ays in view.  
r

alw

Points plot on the screen as shots are t aken.  

 If preferred, points ma
interface. 

 
Figure 90: Store Points Interface 

The icons on the left of the Store PTS interface are 
or zooming and panning. For GPS, coordinates, f
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status (Fixed, Float, Aut
VRMS accuracy estimat

onomous) and HRMS and 
es are displayed at all times. 

Table 13: Store Points Interface Icons 
Description Icon 

 

is icon or press the 
 key on the Explorer 600+ to store 
s.   

and description prompt are not 
turned on, enter antenna height, description, 
or point ID changes prior to taking the shot. 

Store Points – Tap th
Enter
point

If the height 

 

gs to 
average. After the readings are taken, a 
window displays the range and standard 

With GPS, since shots tend to cluster around 
the true point location, it may add to th

o Average 10 or more GP

Average – Set the number of readin

deviation of the readings. 

e 

 
precision t S 
readings when taking measurements. 

 

Offset – Set offset reading options, including 
options for keyed-in offsets as well as offsets 
taken by laser devices.  

 

Configure – Configure options that apply to 
field observations, including enabling the 
after-shot antenna height and description 
prompt. Refer to the Configure section above 
for more information. 

 

Monitor/Skyplot – Monitor the status of the 
GPS solution, quality of the position, dilution 
of precision, and satellite status. Refer to the 
Monitor/Skyplot section above for more 
information. 
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Store Points 

 
Figure 91: Survey Menu – Store Points 

1. Select Survey > Store Points (see Figure 91). 
Store Pts graphical interface opens (see Figure
90). 

Collect desir

The 
 

des d period, refer to the Download Static 
Data File section of Appendix D for instructions to 
download the static data file from the base GPS. 

Additional SurvCE options most useful for producing 
survey results are described briefly in the section 
which follows. Refer to the Carlson SurvCE manual 
for detailed instructions.  

 

 

 

 

2. ed points/positions. 

The LAND-PAK is now setup and operating to the 
point of collecting positions with RTK. After the 

ired elapse
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Additional SurvCE Options 

Localization 

 
Figure 92: Equip Menu – Localization 

l coordinate system is the inIf a loca tended basis for 
the s v
field. Th
relation the 
local co tes 
will be available for view or staking.   

Select E
trans r

Figure 93). 

 
i

rred to here as an RTK 
S

 
f

s 
eld survey progresses, points 

with known grid coordinate positions may be 

ur ey, locate and store the local points in the 
en use Localization to compute the 

ship between the GPS coordinates and 
ordinates. Thereafter, the local coordina

quip > Localization to apply a best fit 
mation using a localization. The localization 

submenu has two options (see 
fo

Localization in the context of SurvCE 
s a method to relate the coordinates 
of a survey that are based initially on a 
Starfire position or a GPS navigation 
solution refe

olution.   

The GPS navigation solution may be within 10
eet on WGS84 and the StarFire™ position 

may be within 0.3 feet after 30-45 minute
period. As a fi
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include
of a transfor

d in the survey re
m

system.  

quiring the application 
ation to work in the local 

 
Figure 93: Localization Submenu Options 

ect the RTK Localization button. The LocalizationSel
submenu opens (see Figure 94). It h
tabs are displayed below. The TS ta
applicable to GPS. 

 
as five tabs. Four 
b is not 

 The Localization submenu provides 
the same options for either type of 
localization, RTK or Starfire. Refer to 
the supplied Carlson SurvCE manual 
for the use of this tool. 

 
Figure 94: Localization Submenu – System Tab 
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ion Submenu – GPS Tab Figure 95: Localizat

 
Figure 96: Localization Submenu – Points Tab 

 
ure 97: Localization Submenu – By Helmert Fig
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Stake Points 

 
Figure 98: Survey Menu – Stake Points 

Selec stake 
points, for e ction 

son  
X-P

 
options can be 

set which determine how directions to a 
stake point are provided.  

t Survey > Stake Points to navigate to and 
xample, boundary corners or constru

grade stakes. Stake points are: 

 Points that have been determined in relationship 
to other measured points in the field 

 Points contained in a coordinate data file 
transferred to the Explorer 600+ with Carl

ort software 

Review the Job Settings section above 
before staking. Various 
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 Stake Points 

 
Figure 99: Stake Points Window 

Refer to Figure 99 for the settings below. 

Methods to select a point to stake: 

 Enter the point number in the Point ID field. Press 
the Enter button on the 
view the elevation, northing and easting. 

 A range of points can be staked out. 
For example, 3-10, 2,15-20 entered 
into the Point ID field would stake out 

sequentially. 

 Open the job file or control file. Tap the 

Explorer 600+ keyboard to 

the points from 3-10 sequentially, then 
point 2, then 15 through 20 

 button 
to select one or more points from the Point Details 
window. 

 Tap the  button to open the graphical view. 
Tap on a point to stake.   

The remaining options on the Stake Points window 
are described below:  

• Add To List and Pick From List buttons: Create a 
list of points to be staked. Tap the Add to List 

5-130 
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button to add the current point in the Stake Points 
window to the list. Tap the Pick from List button to 
view the Stakeout Point List window and stake 
any of the points on the list.  

• Source: After selecting a point or points in the 
Stake Points window, SurvCE displays the source 
of the point(s), either as Current Job or Control 
File.  

 The display of the source is important 
because the current job file and a control 
file may contain the same point ID.  

• Point by Direction: Check this option to st e a 
poi d 

ak
nt defined by a direction and distance, an

slope if applicable, from the current point 
coordinate. This enables points to be staked 
without calculating point numbers or point IDs for 
the target point. Enter t e beh aring/azimuth, 
horizontal distance and also slope, if applicable. 

 If the distance entry is not known but 
must be computed, access the 
calculator. Tap in the H. Distance field. 
Press the 2nd button on the Explorer 
600+ keypad. Press the 0/? key. The 
calculator opens. 
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Points 

 
Figure 100: File Menu – Points 

Select File > Points to view all of the points in the 
pens (see Figure 

edited or deleted. Points can 
be added. 

current open job. The Pts window o
101). Any point can be 

 
Figure 101: Points Submenu 

5-132 
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Feature Code List 

 
Figure 102: File Menu – Feature Code List 

ect File > Feature Code List to define feature code 
s. Multiple feature code lists can be created. Each
can contain an unlimited number of codes.  

 Each feature code consists of a short 

Sel
list  

COGO Me

Refer to the supplied Carlson SurvCE manual for 
information on typical COGO applications useful in a 
field survey. 

 

 

list 

code, a longer description, a polyline 
toggle and a polyline type setting. 
Refer to the supplied Carlson SurvCE 
manual for additional information on 
feature codes.   

nu 
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Chapter 6 ............................Data Transfer 

Carlson X-Port software is a file transfer and data 
editing utility designed to aid in the processing of 
electronically collected data files. Although intended 
for both conventional and GPS survey instruments, 
only the application to GPS is addressed here. This 
chapter is a condensed version of the Carlson X-Port 
manual.   

Installation 

The s he upplied Carlson SurvCE CD, at the rear of t
Carlson SurvCE manual, contains: 

 X-Port utility software (XPortSetup.exe) 

 Geoid models (CarlsonGeoidGrids.exe)  

 Current versions of these exe files and 
the Carlson X-Port manual are 
available at www.carlsonsw.com. 

X-Port: 

PortSetup.exe to a folder on the PC an
the program. When a serial number is requested,

mber provided on

Install 

Copy X d run 
 use 

the nu  the plastic pocket at the rear 
urvCE manual.   

rogram. The installed geoid models 
clude Geoid 1999, Geoid 2003, and EGM (Earth 
ravity Model for the world). Unless otherwise 
pecified, these files are installed in the same folder 

as X-Port.   

 

of the Carlson S

Install Geoid Models: 

Copy CarlsonGeoidGrids.exe to a folder on the PC 
and run the p
in
G
s
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Introduction 

Carlson SurvCE software, which runs on the Explorer 
00+ data collector, creates a number of files to 
upport a project in the field. Two primary files are 

created for each project:  

 A coordinate file appended with .crd 

 A raw data file appended with .rw5 

The coordinates, measured or computed are stored in 
he job .crd file. The raw data associated with these 
oordinates is saved in the .rw5 file which allows for 

re-processin
ffect the c

n the offic
Explorer 

The top half 
bottom half is the 
editors function as spreadsheets. Each row 
represents one record of data. 

6
s

t
c

g in the event changes are made that 
oordinate values. 

e, use X-Port to communicate with the 
ates, 

of X-Port is the Raw Data Editor. The 
Coordinate Data Editor. Both 

a

I
600+, transfer files, process coordin

and convert coordinates and raw data formats.   

 
Figure 103: X-Port Data Editors 

The lines of data in a .rw5 file are like the records in a 
surveyor’s field book. Use X-Port to edit and add to 
the .rw5 file and re-process the raw measurements to 

Raw Data Editor

Coordinate
Data Editor 
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update the coordinates, if necessary, in an existing or 
new .crd file.   

Although this is intended primarily for a convention
instrument, X-Port provides the ability to edit into t
.rw5 file additional offset measurements (bearings 
and distances) obtained during the GPS survey for 
processing sideshots from RTK points.   

 Refer to the Carlson X-Port manual for 

al 
he 

the file formats supported by the raw 
data and the coordinate data editors.  

seful for converting, transferring, and 
printing reports are demonstrated in the following 

 File 

contain ew and 

 the Explorer 600+ for use in the field as 

on the PC. The raw data and the 

Commands u

exercises.   

Exercises 

 Exercise 1: Import/Convert Text File to CRD

This exercise provides steps to import a text file 
ing coordinates into X-Port for revi

o a *.crd file. The *.crd file can be conversion t
transferred to
a “Control File”. The file could contain coordinates of 
control points intended for a base station, for a 
transformation to a local coordinate system, or for 
points to be staked in the field.   
 
1. Run X-Port 

coordinate data editors are blank at start-up.  

2. Select Tools > Import Point Data > Text/ASCII 
File. The Import Point Data window opens (see 
Figure 104).  
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Figure 104: Import Point Data Window 

3. Click the Select Text File button and browse to 
and select the desired file. The Import Point Data 

a 
d. 

on. 
alf of 

File > Save CRD 
as. Browse to a location. Save and name the file. 

 Exercise 2: PC/Explorer File Transfer 

This exercise provides steps to transfer file
PC to the Explorer 600+. The transferred file may be 
the .crd file created in Exercise 1 above or an 
ASCII/text file.   

1. Run X-Port on the PC. 

2. Connect the Explorer 600+ to the PC with the 
supplied USB cable (in the rover transit case).  

3. On the

window returns. 

4. In the Common Formats drop-down list, select 
format. It appears in the Coordinate Order fiel

5. Preview the file. If acceptable, click the OK butt
The imported points are listed in the lower h
X-Port. 

6. In the X-Port menu bar, select 

s from the 

 Explorer 600+, run SurvCE. 

4. In SurvCE, select File > Data Transfer. The Data 
Transfer window opens (see Figure 105). 
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Figure 105: SurvCE Data Transfer Window 

5. Accept the default COM Port setting, COM1.  

6. Tap the Carlson/C&G Transfer button. The 
Explorer 600+ waits for a connection. 

orer 

b. In the left panel (Local PC), browse to and 
select the file to transfer from the PC to the 
Explorer 600+.   

7. In X-Port
SurvCE/G2/

, select Tools > Data Transfer > 
FastSurvey/SurvStar. X-Port opens 

the SurvCom window on the PC, and connects to 
the Explorer 600+. SurvCom provides access to 
folders and files on both the PC and the Expl
600+.   

 If the connection fails, select Options 
from the SurvCom window. Change 
the COM port to ActiveSync. Select 
Connect. If ActiveSync opens a box 
with the message, “Set up 
Partnership”, select No. Click the Next 
button. The connection is now active.   

Transfer a file using SurvCom: 8. 

a. In the right panel (Remote), browse to the 
System CF folder and open the Data folder. 
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c. Click the Transfer button. 

d. Verify the file appears in the Data folder. 

 A text file can be converted to a .crd 
file on the Explorer 600+. Use the   
File > Import/Export command.   

 Exercise 3: Create/Upload Geoid File to Explorer 

1. Run X-Port. 

Connect the Explorer 600+ to the PC with the 
plied USB cable (in the rover transit c

of the 
e 

2. 
sup e). 

3. 

4. In SurvCE, select File > Data Transfer. The Data 
Transfer window opens (see Figure 105). 

as

On the Explorer 600+, run SurvCE. 

5. Accept the default COM Port setting, COM1.  

Tap the Carlson/C&G Transfer button. The 6. 
Explorer 600+ waits for a connection. 

In X-Port, select Tools > Data Transfer > 
SurvCE/

7. 
G2/FastSurvey/SurvStar. X-Port opens 

the SurvCom window on the PC, and connects to 
the Explorer 600+. 

8. Select the Geoid button at the bottom 
window. The Set Geoid Area window opens (se
Figure 106). 
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Figure 106: Set Geoid Area Window 

Refer to Figure 106 for the steps below: 

9. Click the  button and browse to an
select a geoid file. C:\Program Files\C

d 
arlson X-

Port is the default installation location of the geoid 
files.   

 Select the Geoid Type (usually Geoid 2003).  

 Enter the Latitude and Longitude near the center 
of the area to be surveyed.   

10.

 

 

 

 

 x /or Save CRD and RW5 Files 

11.

12. Enter the Grid size.  

 The minimum Grid size is a 50 miles 
square. A Grid size greater than 150 
miles slows processing. 

er a Grid Name 

k the OK button. The file is created with

13. Ent

14. Clic
extension .gsf, and uploaded to 
the Explorer 600+. 

 the
the Data folder on 

E ercise 4: Print and
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Thi

 

 e X-Port to print and/or save each file 
 

Set up the Explorer 600+ and PC for file transfer

s exercise provides steps to: 

Transfer a *.crd and a *.rw5 file from the Expl
60 + to the PC  

orer 
0

 

r 

with the transferred *.crd file. 

b. Select the *.crd file. The coordinates in the file 
are displayed in the lower half of X-Port. 

c. Select File > Print > Coordinates. The Print 
Coordinates window opens (see Figure 107).  

Us to a text 
file 

1. . 
Refer to Exercise 2, Steps 1 to 7 for details. 

2. Using SurvCom, transfer a *.crd file and a *.rw5
file from the Explorer 600+ to the PC: 

a. In the left panel (Local PC), open the 
C:\Program Files\Carlson X-Port
it is not already open. 

\Data folder, if 

b. In the right panel (Remote), browse to and 
select the *.crd file and *.rw5 file to transfe
from the Explorer 600+ to the PC.  

c. Click the Transfer button. 

d. Verify the files appear in the Data folder. 

3. Exit SurvCom.  

Run X-Port. 

Perform the following ste

4. 

5. ps to print and/or save 
the CRD File: 

a. Select File > Open CRD File. A window opens 
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Figure 107: Print Coordinates Window 

d. Determine the data that will be output from the 
*.crd file. Enter the range of points. Th  range 

 is 

r save 

 > Raw Data. The Carlson 
X-Port Edit window opens with the data in the 

e
will be displayed as a list of coordinates. 
Check List Point Notes to output t
RMS, coordinates of staked points, 

he time, 
etc. 

e. Click OK. The Carlson X-Port Edit window 
opens. It displays the specified data. 

f. Print and/or save the data as a text file. 

 There is another method to print 
and/or save a *.crd file as a text file. 
Select Tools > Export Point Data > 
Text/ASCII File. The text file created

6. Perform the following steps to print and/o
th  RW5 File: 

a. Select File > Open RW5 

a list of coordinates.  

e

wi
File. A window opens 

red *.rw5 file. 

b. Select the *.rw5 file. The file is displayed in 
the top half of X-Port. 

c. Select File > Print

th the transfer

file. The data is a detailed field note record. 

d. Print and/or save the data as a text file. 
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 Exercise 5:  Process GPS From RW5 File   

This exercise provides steps to process GPS for 
ad itional details, geodetic and grid coordinates, 
geoid heights, rod height

d
s, etc. from the *.rw5 file. 

 

1. 

2. 

 

Thi
GP

Add Menu 

Adding records to a *.rw5 file is most useful when 
there are some additional conventional field traverse, 

IMPORTANT: The output from 
Process (Compute Points) > GPS 
contains the grid coordinates and 
elevations on the points. However, the 
latitude, longitude and ellipsoid 
heights are at the L1 phase center.  
The Rod Height is from the point to 
the L1 phase center. 

Transfer a *.rw5 file from the Explorer 600+ to the 
PC. 

n X-Port on the PC. 

 Process (Compute Points) > GPS

Ru

3. Select
Process Options window open

. The
s. 

Set the necessary parameters.  4. 

5. Click OK. 

6. Print and/or save the results.  

Menus & Commands 

s se nds specific to 
S.  

 Refer to the Carlson X-Port manual for 

ction describes X-Port comma

information on menus and commands 
not described in this section. 
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sideshot or description information to be computed or 
included in the final processing for the job or project.   

Methods to add records to a *.rw5 file in the X-Port 
raw data editor: 

 Select one of the options from the Add menu  

 Press the Insert key on the keyboard 

 Select the last line in the spreadshee and p

 

Insert 
rec

1.  

2.  

n

 Not

. 

Ele

1.  

 

ns
The
des
dat
sa

t ress 
the 

GPS 

a GPS record into a *.rw5 file. Elements of this 
include: 

nt ID (PntID) 

down arrow key 

ord 

Poi

Latitude in dd.mmss 

gitude in dd.mmss (Negative for West) 3 L.  

5.  Description (Desc) 

e 

 descriptive note record (DS) into a *.rw
scriptive note record is an additional note

he raw data editor and p

o

4.  WGS84 Ellipsoid Elevation (Elevation) 

Insert a 5 file
The de  that 
appears in t rintouts. This 
record is not used in processing.   

ments of this record include: 

Note 

Point (To RW5 File) 

 stored coordinatI ert a e record (PT) into a *.rw5 file. 
 *.rw5 file, when viewed by a text editor, will 
ignate this record as “SP”. When processing, this 

stored as a point in the coordinate file for the 
b. Elements of this record include: 

a is 
me jo
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1.  Point ID (PntID) 

2.  Northing 

3.  Easting 

4.  Elevation 

5. es

 Poi

Insert a e.  
Eleme

Compute Points) 
 processing a *.rw5 
oints in a *.crd file.  

ate plane 
coordinates from geodetic coordinates. The Carlson 

ventional traversing.  

ocal 
coordinates. e:  

i
2.  Lati

 in dd.mmss (Negative for West) 

 D cription 

nt (To CRD File) 

 stored coordinate record into a *.crd fil
nts of this record include: 

nt ID (PntID) 

thing 

1.  Poi

2.  Nor

3.  Easting 

4.  Elevation 

5.  Description 

Process (Compute Points) Menu 

The commands under the Process (
menu provide 
file and for storing the ca

various methods for
lculated p

For GPS, this command computes st

X-Port manual details con

 GPS 

Convert the GPS records in a *.rw5 file from latitude, 
longitude and ellipsoid heights to state plane or l

 Elements of the GPS record includ

1.  Po nt ID (PntID) 
tude in dd.mmss 

3.  Longitude
4.  WGS84 Ellipsoid Elevation (Elevation) 
5.  Description (Desc) 
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Select Process (Compute Points) > GPS. The 
Process Options window opens (see Figure 108). 

 
Figure 108: Process Options Window 

for the settings below: 

the datum and coordinate 

e GPS 

the United States, two separate 
horizontal control systems have been 

r 
M (Universal 
 System) can 

: For State Plane projections, the correct 

e applied 

Refer to Figure 108 

• Projection Type: Define 
system used to convert the Latitude, Longitude 
and Ellipsoid Heights collected from th
receiver into Cartesian coordinates.  

 For 

developed by the Federal 
Government: State Plane based on 
NAD 1927, and State Plane based on 
NAD 1983. In the US and fo
International use, the UT
Transverse and Mercator
be selected. 

• Zone
state zone for the job location must be selected. 
For UTM, the automatic zone option will 
automatically use the correct UTM zone for the 
job location, or a specific UTM zone can be 
manually set. The manual option may b
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to surveying on t
the program to u

he border between zones to force 
se a particular zone. 

mation: This two dimensional 
mation option can either be by Plane 

 or dy methods. Both methods 
t-f uares transformation. The 

rigid body method does a 
 translation and rotation and 

ne similarity does a 

used in 
nsformation). 

t Alignment Azimuth: This option applies 
ation when using one point in Align Local 

Coordinates. Select which north to use. For this 
 method, the state plane coordinate is 

o the local coordinate. Then the 
use either the state plane grid or the 

plied in this 
geodetic true 

d in survey calculations. In order to 

S measured ellipsoid heights 
ns by Carlson) referenced to 

d (equal potential 

g in 
onal 

• Transfor
transfor
Similarity
use a bes

Rigid Bo
it least sq
 that the 

transformation with a
without a scale. The pla

difference is

rotation, translation and scale. This option only 
applies when two or more points are 
Localization (tra

• One Poin
to the rot

alignment
translated t
rotation can 
geodetic as north. No scale is ap
transformation. The state plane and 
north diverge east and west of the state plane 
zone central meridian.    

• Geoid To Apply:  This option will account for the 
geoid undulation in determining the orthometric 
heights (elevation) of the measurement.  
Orthometric heights or elevation measurements 
are use
convert ellipsoid heights h (He in Carlson 
documentation) as measured by GPS into 
orthometric elevations H (Eo in Carlson 
documentation), a correction must be provided for 
between the GP
(called GPS elevatio
the ellipsoid and the geoi
surface approximating global sea level). This 
correction is the geoid undulation N (U
Carlson documentation). The conventi
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formula is h=H+N; (He=Eo + Ug in Carlson 
documentation). The geoid models are essenti
geoid height difference models in a grid format.  

ally 

X-Port has two geoid models available covering 
the United States at 1 minute grid intervals 
(Geoid03 and Geoid99); and EGM96 covering the 
entire globe at 15 minute intervals. These geoid 
models are huge and take a lot of disk space.  
X-Port applies the geoid model by subtracting the 
geoid undulation from the GPS measured 
ellipsoid height. The result is then used and 
displayed. In practice, the geoid model is most 
applicable to two types of scenarios. One of these 
types is when setting up the base over a known 
poin

on 
e 

Units ne of 
thre
Inte

• Sca G 
fro

 
e 

 

t and an elevation is known or assume
the best relative orthometric heights are de

d and 
sired at 

g multiple 
vertical control points in a three dimensional 
solution. The geoid model is a good check and 
can be better than solving for a 3D transformati
because the local control points can have mor
ertical error than the geoid model. 

other points.  Be cautious when usin

v

• : Coordinates can be converted into o
e available units, Metric, US Feet or 
rnational Feet. 

le Factor: After converting the LAT/LON
m the GPS records to state plane coordinates 
 applying the coordinate alignment 
calization, a.k.a. transformation) file, the

Project Scale Factor

and
(Lo  

 is applied as the final 
adjustment to the coordinates. This adjustment is
used on the X, Y and not the Z. The Project Scal
Factor is applied by dividing the distance between
the coordinate and a base point by the Project 
Scale Factor. The coordinate is then set by 
starting from the base point and moving in the 
direction of the coordinate for the adjusted 
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distance. The base point is the first point in the 
alignment (Localization) file. If there are no points 
specified in the alignment (Localization) file, then 
0,0 is used as base point. The second dialog will 
prompt if an alignment (Localization) file is to be 
used during the process. This file is typically 
created by SurvCE using the Localization routine. 
The file (*.dat) contains the parameters to 
transform the derived State Plane coordinates to 
the defined local coordinates. At the end of the 
process, the coordinates will be written to the 
current *.crd file and a report will be presente
the Carlson editor for saving o

 

 

 

 

 

 

 

d in 
r printing purposes. 
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Ch

Us
equ
con
inst

Tra

Alw
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min
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wit
equ
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c
st

n

s
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tem
tha

Ba

Dis
ma . 

apter 7 ........... Equipment Maintenance 

ers must be familiar with the use of portable GPS 
ipment, radio modems, Bluetooth-enabled 
trollers, the limitations thereof and these safety 
ructions prior to use of the LAND-PAK. 

nsport 

ays carry the LAND-PAK equipment in the transit 
es. The cases must be secured during transport to 
imize shock and vibration. 

intenance 

 LAND-PAK equipment must be properly cleaned 
h the appropriate materials. The NavCom 
ipment may be cleaned using a new lint free cloth 

istened with pure alcohol. Manufacturer’s 
ipment other than that of NavCom Technology, 

. must be cleaned in accordance with the 
ructions issued by the manufacturer. 

Connectors must be inspected, and 

In
in

if necessary 
cleaned before use. Always use the provided 
co nector protective caps on the GPS to minimize 
moisture and dirt ingress. 

In pect cables regularly for kinks and cuts as these 
m y cause interference and equipment failure. 

mp GPS equipment must be dried at a 
perature less than +40°C (104°F), but greater 
n 5°C (41°F) at the earliest opportunity. 

ttery Disposal 

pose of batteries safely in accordance with 
nufacturer’s specifications and local regulations
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Sa

Th
use
equ
and

Ma

saf
incl
atta
equ

Alw
egulatory practices for safety and health at work. 

here are no user serviceable parts inside the 
avCom SF-2040 GPS sensor. Accessing the inside 
f the equipment will void the equipment warranty. 

ake care to ensure the SF-2040 does not come into 
ontact with electrical power installations, the unit is 
ecurely fastened and there is protection against 
lectromagnetic discharge in accordance with local 

regulations. 

 

 

 

 

 

 

 

fety First 

e owner of the LAND-PAK must ensure that all 
rs are properly trained prior to using the 
ipment and are aware of the potential hazards 
 how to avoid them. 

nufacturer’s equipment other than that of NavCom 
Technology, Inc. must be used in accordance with the 

ety instructions issued by the manufacturer. This 
udes other manufacturer’s equipment that is 
ched to NavCom Technology, Inc. manufactured 
ipment. 

ays use the equipment in accordance with local 
r

T
N
o

T
c
s
e
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A....... The LAND-PAK 869 Inventory Check 

 is shipped in five boxes, which contain 
the transit cases and bags listed below. The transit 

This appendix provides the complete system 
inventory for the LAND-PAK 869 configuration. It is 
divided into three sections: Base Station Inventory, 
Rover Inventory, and Office Supplies Inventory. 

The system

cases are labeled on the top. The bags are labeled 
under the NAVCOM logo.  

 Base Station Transit Case 

 Base Bag 

 Rover Transit Case 

 Rover Bag 

 Office Supplies Transit Case 

 Carefully remove equipment from 
transit cases and bags. If any items 
are missing or damaged, immediately 

tech.com/Contact/Contact

contact NavCom Customer Support: 

Telephone: +1 (310) 381-2000 

Web:  
http://www.navcom
Support.cfm 
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Base Station Inventory 

This section lists all the supplied equipment in the 
Base Transit Case and the Base Bag. 

 

tend 
(P/N 97-310041-3009) 

Figure 109a: Base Transit Case Supplied Equipment 

Table 14: Base Transit Case Parts List 

1 

SF-2040 GIS PM Sensor 
(P/N 92-310045-3001) 
Included and Installed Software Options: 

RTK Software 
(P/N 97-310041-3006) 
RTK Ex

2 Two Lithium-Ion Battery Packs, 10.8 VDC, 4.4 Ah 
(P/N 59-020102-3001 each) 

3 Tribrach, w/ Optical Plummet, black 
(P/N 60-990007-0001) 

4 Adaptor, Tribrach, Fixed 
(P/N 60-990008-0001) 

5 
Base Transit Case {Not Shown} 
(P/N 79-100106-3001) 

 Continued on next page 
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se Supplied Equipment 

ist continued 

 
Fi ure 109b: Base Transit Cag

Base Transit Cas
3ASd 869 Radio Modem 

e Parts L

01-0003) 
6 

(P/N 82-0420

7 
3ASd Battery Cradle  
(P/N 60-990011-0001) 

8 
3
(
ASd Battery with switch 
P/N 59-020201-0001) 

9 
B
(

ag for 3ASd Radio Modem 
P/N 79-700005-0001) 

10 15-0002) 
Antenna, 869 
(P/N 82-0010

11 
R
( 012) 

adio Antenna Cable, 12 ft (3.7m) 
P/N 94-310058-3

12 
NavCom Cable, DB-9  
(P/N 73-100002-0002) 

13 
Tape Measure & Pocket Rod Combo, 12ft (3.69) 
(P/N 60-990009-0001) 
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Figure 110: Base Bag Supplied Equipment 

Table 15: Base Bag Parts List 

1 Bag, Tripod {Not Shown} 
(P/N 79-700003-0001) 

2 Leg
Tripod, Dual Lock, Fiberglass, Waterproof, 72 in (1.84m) 

s 
(P/N 60-430002-0001) 

3 o Tripod  Bracket, Radio Antenna T
(P/N 60-500001-0001) 

4 Snap-Lock Radio Antenna Pole, 6ft  (1.84m)  
(P 02-0001) /N 60-4400

5 P n diameter 
(P

ole Extension
/N 60-440003-0001) 

, 6 inch: 1 i

6 Radio Antenna Adaptor 
(P/N 88-310055-3002) 
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Rover Inventory 

This section
Rover Trans

 lists all the supplied equipment in the 
it Case and the Rover Bag. 

 
ur t Case Supplied Equipment 

ransit Case Parts List 

1 

S
(

ware Options: 

Fig e 111a: Rover Transi

Table 16: Rover T
F-2040 GIS PM Sensor 

P/N 92-310045-3001) 
Included and Installed Soft

RTK Software 
(P/N 97-310041-3006) 
RTK Extend 
(P/N 97-310041-3009) 

2 T VDC, 4.4 Ah  
(

wo Lithium-Ion Battery Packs, 10.8 
P/N 59-020102-3001 each) 

3 S ) iled 
(

erial Cable, 6 Ft (1.84m Co
P/N 94-310090-3003) 

4 T
(

ruBlu™ Module   
P/N 92-210182-3001) 

5 er 600+, Carlson SurvCE w/GPS installed
(P/N 82-061001-0001) {Supplied USB Cable Not Shown} 
Carlson Explor

6 
Rover Transit Case {Not Shown} 
(P/N 79-100107-3001) 

 Continued on next page 
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Figur ment 

Rov ued 
of 3) for Carlson Explorer 600+ 

) 

e 111b: Rover Transit Case Supplied Equip

er Transit Case Parts List contin

7 
Extra Orange Styli (Set 
(P/N 60-990010-0001

8 
Screen Protectors for Carlson Explorer 600+, Set of 5  
(P/N 60-220001-0001) 

9 
Vehicle Charger for Carlson Expl
(P/N 59-800004-0001) 

orer 600+  

10 
3ASd 869 Radio Modem 
(P/N 82-042001-0003) 

11 
3ASd Battery Cradle  
(P/N 60-990009-0001) 

12 
3ASd Battery with swit
(P/N 59-020201-0001

ch 
) 

13 
Bag for 3ASd Radio Modem 
(P/N 79-700005-0002) 

14 
Antenna, 869 
(P/N 82-001015-0002) 

15 
NavCom Cable, DB-9  
(P/N 73-100002-0002) 
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Figure 112: Rover Bag Supplied Equipment 

Table 17: Rover Bag Parts List 

1 Rover Bag {Not Shown} 
(P/N 79-700002-0002) 

2 Pole, Carbon Fiber and Aluminum, 8.5 ft (2.61m) 
(P/N 60-430001-0002) 
Bipod, Carbon Fiber, Open Clamp  3 (P/N 60-430001-0001) 
Cradle for Carlson Explorer 600+  
(P/N 60-570002-0001) 4 
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Office Supplies Inventory 

This section
Office Supplies Transit

 lists all the supplied equipment in the 
 Case.  

 
Figure 113: Office Supplies Transit Case 

1 

B r Kit for SF-2040 GIS PM Sensor 
(P

Cable (P/N 92-310046-3001) 
P/N 82-02003-5001) 

Table 18: Office Supplies Transit Case Parts List 
attery Charge
/N 92-310092-3001) 

Kit Includes: 
4-Bay Battery Charger w/ 
Charger Power Supply (

2 (
B arlson Explorer 600+ 
P
attery Charger Kit for C
/N 59-810001-3001) 

3 

O
(x r for 3ASd Radio Modem 
B
O
(x r for 3ASd Radio Modem 
B 800001-0002) {Not Shown} 

ption: 
2) 110V Battery Charge
attery (P/N 59-800001-0001) 
r 
2) 220V Battery Charge
attery (P/N 59-

4 O  {Not Shown} 
(P

ffice Supplies Transit Case
/N 79-100108-3001) 

 Continued on next page 
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Office Supplies Transit Case Parts List continued 

5 User Guide, LAND-PAK  
(P/N 96-310030-3001) 

6 
User Guide, SF-2040  
(P/N 96-310003-3001) 

7 User Guide, Carlson Explorer 600+ 
(P/N 96-000001-0001) 

8 User Guide, Carlson SurvCE  
(P/N 96-000001-0002) 

9 
User Guide, SATELLINE -3ASd Radio Modems 
(P/N 96-000001-0003) 

10 

d 

(P/N 9

CD containing User Guides, Reference Material, an
StarUtil Utility Software/User Guide 

6-310006-3001) 
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B ns 

s 
Confi

ig

.............. Additional Base Position Optio

Thi appendix provides information on the Base 
ons not described in the 
ction in Chapter 5.  

guration window opti
Ass n a Base Position se

 
Figure 114: Base Configuration Window 

From New Position Tab 

 Enter Lat/Lon 

Tap the Enter Lat/Lon button if the base is on a 
known GPS Control Point. The Enter Lat/Lon window 
opens (see Figure 115). Enter the geodetic position, 
including the ellipsoid height. 
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Figure 115: 

 Enter Grid System Coordinates 

ap the Enter Grid Syste
igure 114) if the state p

The Grid 
Enter or 
he Explorer 600+.  

Enter Lat/Lon Window 

m Coordinates button (see 
lane coordinate is known. 

re 116). 
 on 

T
F

Coordinate window opens (see Figu
select the coordinates from a file stored

t

 
Figure 116: Grid Coordinate Window 
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From Known Position Tab 

 
Figure 117: From Known Position Tab 

 Previously Surveyed Point 

Tap the Previously Surveyed Point button to select 
the co  The 
Surveyed Point window opens (see Figure 118).  

ordinates from a file on the Explorer 600+.

 
Figure 118: Surveyed Point Window 

 Use Local Coordinates 

Tap the Use Local Coordinates button to access the 
Local Point window (see Figure 119). Enter the local 
coordinate values or select the coordinates from a file 
on the Explorer 600+. 
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Figure 119: Local Point Window 

Tap  to accept the settings. The Localization File 
ile to facilitate 

Tap the Read From File button (see Figure 117) to 
select a previously stored position in a *.ref file. The 
Base Station File window opens (see Figure 120).  

 A *.ref file usually is selected to 
continue working on a project. 

window opens. Select a localization f
the computation of a WGS84 (GPS) coordinate from 
the local coordinate. The Localization file is a 
transformation solution previously determined for a 
project. 

 Read From File  

Figure 120: Base Station File Window 
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C ................................ TruBlu Configuration 

This appendix provides steps to install and configure 
the supplied TruBlu™ module. TruBlu provides 
wireless control and logging of up to 10Hz position 
records in the Explorer 600+ controller.  

COM1 of the SF-2040 GPS sensor, both base and 
rover, is the LAND-PAK Control Port. Prior to the 
installation of TruBlu, the supplied serial cable (P/N 
94-310090-3003) is used to connect the Explorer 
600+ controller to COM1 to set its baud at 19200. 
This is important because TruBlu only works at 19200 

u

low: 

supplied 
or. 

2. Power up the SF-2040 GPS sensor: on the 
indicator panel of the sensor, depress the on/off 
(I/O) switch for more than 3 seconds.  

 All GPS sensor LEDs illuminate for a 
period of 3-5 seconds during power-
up. Refer to the supplied SF-2040 
GPS Product User Guide for details 
on GPS sensor LED indications.  

Press the Explorer 600+ power button 

ba d. 

Refer to 

1. Connect the LEMO 7-Pin end of the 

Figure 51 for the cable connections be

serial cable to COM1 of the SF-2040 GPS sens
Connect the female 9-pin serial connector end to 
the Explorer 600+ controller. 

3.  to 
boot up the Windows CE desktop. The icon for 

con on the desktop. The 

Carls

4. Double tap the SurvCE i

on SurvCE is on the desktop. 

SurvCE job selection box opens in front of the 
main menu. 
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5. Tap the Continue Last Job button or the Select 
New/Existing Job button.  

• If the Continue Last Job button is tapped, a 
connection is established. If the Select 
New/Existing Job button is tapped, the 
Coordinate Files window opens. For 
instructions on setting up a new job, refer to 
the Create A New Job 

•  section in Chapter 5 SurvCE Software 
Operation. 

6. Select  is Equip > GPS Rover. A connection
established. The GPS Rover window opens. 

7. Tap the Comms tab. 

8. In the Baud drop-down list, select 19200 (see 
Figure 121).  

 
Figure 121: TruBlu Baud Rate Setting 

9. Tap  to accept the setting and connect to the 
GPS sensor. A connection is established. 

10. Remove the serial cable from the SF-2040 GPS 
sensor and the Explorer 600+. Do not exit SurvCE 
on the Explorer 600+.  

11. Insert TruBlu in COM1 of the SF-2040. The red 
lue. dot on TruBlu must face up. TruBlu blinks b
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12. In the Type drop-down list on the Comms tab, 
select Bluetooth. A box opens with the message:  
Bluetooth COM Port: COM6 has been 
successfully set! 

13. Tap OK on the message box. The Comms tab 
displays: 

• Type: Bluetooth 

• Device: Atinav 

• Instrument: (blank) 

• Port: Com 6 

14. Tap the Configure button on the Comms tab. The 
Bluetooth Devices window opens (see Figure 
122). 

 

 

 

6. Tap the appropriate TruBlu module to select it.  

Figure 122: Bluetooth Devices Window 

15. Tap the Find Receiver button at the bottom left. 
box opens with the message: Looking for 
Bluetooth devices… 

A

A window opens with a list of all Bluetooth 
compatible devices in the vicinity. TruBlu modules
are listed with a four digit serial number. 

1
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17. Tap  to accept the selection. The TruBlu 
module is listed in the Bluetooth Devices window. 

18. Tap the Bluetooth icon  at the top right of the 
window. A box opens with the message: Bonding

h Bluetooth. 

e Comms tab opens when the TruBlu module 
ded. The selected TruBlu module is listed in 
Instrument field. 

 
wit

is 
n

Th
bo
the 

 Tap 19.  to accept the settings. The Bluetoot
dule is bond

h 
mo ed and a connection is 
established. The SurvCE main menu returns. 
the GPS Rover option, the check mark next to
rover icon verifies the connection (see Figure 

On 
the  

 
Figure 123: Verification of TruBlu Connection 

 

 

 

 

123). 
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D ...............................Static Data Collectio

s appendix provides steps to: 

Collect static observatio

n 

to 

 

Thi

 ns for post-processing 
compute a static network tie. For example, this 
might involve computing a position from CORS 
using the NGS OPU

D wnload a static d

S p

ata 

rocess.  

file after the desired 
d. 

o
elapsed collection perio

Co c alle t Static Dat   

 
Figure 124: Survey Menu – Log Raw GPS 

Connect the Explorer 600+ controller1.  to a GPS 
rec

2. On the SurvCE main menu, select Survey > Log 
Raw GPS (see Figure 124). The NavCom Setup 
window opens (see Figure 125). 

eiver if not already connected.  



 LAND-PAK™ User Guide – Rev. C 

D-172 

 
Figure 125: NavCom Setup Window 

Tap the Start/Resume File button. The Start New 
File window opens. 

Enter a file 

3. 

4. name (DOS naming convention) to 
store the collected data in the receiver memory for 
download later.   

5. Tap . The NavCom Setup window returns. 

6. Tap the Tag Point button. The window displays 
the available onboard memory.   

. Enter a Site Name. It is inserted in the file as a 
point identifier.  

8. Select whether to end the data collection 
manually or after a specified period of time.  

9. In the Recording Site window, select Stop Point 
logging. In the boxes that open, tap Yes and OK.  

 The receiver will continue to collect 
and store data until Close File is 
selected on the NavCom Setup 
window (see Figure 125). 

10. Go to the GPS Rover Setup section to continue 
the initial setup of the LAND-PAK. 

7
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Download Static Data File  

This section provides steps to do
file after the desired stat

wnload a static data 
ic data collection period has 

elapsed. 

Reconnect to the GPS receiver if not currently 
connected. 

 
1. 

2. On the SurvCE main menu, select Survey > 
Raw GPS (see Figure 124

Log 
). The NavCom Setup 

window opens (see Figure 125). 

utton to end the static data 

4. Tap the File Manager button. The Files on 
Receiver window opens (see Figure 126).  

3. Tap the Close File b
collection.  

 
Figure 126: Files on Receiver Window 

5. Tap the file and tap the Download File button. Th
file is transferred from the SF-2040 to the Explore
600+. 

e 
r 

 At a recording rate (epoch) of 1 
second the receiver will collect about 
1.5 MB of data per hour. The 
download to the Explorer 600+ is 
about 1 MB per minute.  
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